
Operating Instructions
Multi Monitoring & Control Software

Multi Monitoring & Control Software 4.0

Windows

Thank you for purchasing this Panasonic product.

■ Before using this software, please read the instructions carefully.
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Introduction

Software Licensing Agreement
Use of this software is governed by the terms defined in this “Software Licensing Agreement”.
By using this software, you are agreeing to the “Software Licensing Agreement”.

1. License
This license grants Licensee the right to use the Software, but does not transfer to Licensee any 
patent rights, copyrights, or any other rights, which remain the property of Panasonic Projector 
& Display Corporation or third parties. Licensee may use the Software only for the purpose of 
managing Panasonic displays (projectors and flat panel displays). Note that the usage rights 
licensed to Licensee by downloading the Software include separate restrictions limiting the 
period of use and the number of displays (projectors and flat panel displays) that can be used. 

2. Use by a Third Party
Licensee may not transfer or allow any third party, to use or copy the Software, whether free of 
charge or not.

3. Restrictions on Copying the Software
Licensee may make one copy only of the Software in whole or in part solely for backup 
purposes.

4. Computer
The Software is for use on one computer owned or managed by Licensee and may not be used 
on other computers.

5. Reverse Engineering, Decompiling or Disassembly
Licensee may not reverse engineer, decompile or disassemble the Software. Panasonic 
Projector & Display Corporation shall not be bound by warranty for any defects in the Software 
caused by reverse engineering, decompiling or disassembly of the Software.
Furthermore, Panasonic Projector & Display Corporation or its distributors or dealers will not be 
responsible for any damage to the Licensee caused by the reverse engineering, decompiling or 
disassembly of the Software.
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Software Licensing Agreement

6. After-sales Service
Panasonic Projector & Display Corporation shall undertake to notify Licensee of whether the 
problem is a known error in the program (“bug”), or whether the way in which the Software 
is to be used should be modified. However, no after-sales service will be carried out for 
problems caused by use of the Software for purposes other than managing Panasonic displays 
(projectors or flat panel displays). Furthermore, the specifications Software is subject to revision 
without prior notice.

7. Indemnification
Panasonic Projector & Display Corporation's responsibility for the Software shall not exceed 
the terms set forth in Section 6 above. Panasonic Projector & Display Corporation and its 
distributors and dealers shall assume no responsibility for any direct or indirect damages or 
losses incurred by Licensee or third party claims against Licensee in connection with the use 
or failure of the Software. Note that the purpose of the Software is to support management 
of Panasonic displays (projectors and flat panel displays). Panasonic Projector & Display 
Corporation and its distributors and dealers do not guarantee the adequacy of the Software, 
the accuracy of its results, or its fitness for Licensee's specific purpose, nor do they guarantee 
that the Software does not infringe on the rights of third parties. Furthermore, please note that 
Panasonic Projector & Display Corporation and its distributors and dealers cannot assume 
responsibility for any problems that occur when downloading files.

8. Export Control
If the Licensee brings the software to another Country other than the Country of purchase, The 
Licensee will follow the regulations of that Country regarding export management.

9. Governing Law and Changes to this Notice
All aspects of the use of this software shall be governed by and interpreted under the laws of 
Japan. Panasonic Projector & Display Corporation may change this notice at its own discretion 
without notifying Licensee.

10. Agreed Jurisdiction
In the event of a need for litigation concerning the use of the Software, Licensee and Panasonic 
Projector & Display Corporation may file an action in Osaka District Court only.
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Request Regarding Security
Be aware of the following security risks when using this software.
• Leakage of your private information via this software
• Illegal operation of this software by a malicious third-party
• Harm to or cessation of operation of this software by a malicious third-party

Be sure to implement sufficient security measures.
• Make sure the password is as hard to guess as possible.
• Change the password periodically.
• Panasonic Projector & Display Corporation and its affiliated companies never directly ask 

customers for their password. Do not give out your password even if directly asked by a third-
party representing themselves as Panasonic Projector & Display Corporation.

• Regularly run Windows Update to keep the operating system on the computer up-to-date.
• Always use on a network that has safety protection such as a firewall implemented.
• Set passwords, and limit the users that are permitted login access.
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Request Regarding Security

Security warnings regarding the usage of Wireless LAN products
 The advantage of a wireless LAN is that information can be exchanged between a PC 
or other such equipment and an access point using radio waves as long as you are within 
range for radio transmissions.
 On the other hand, because the radio waves can travel through obstacles (such as walls) 
and are available everywhere within a given range, problems of the type listed below may 
occur if security-related settings are not made.

• Interception of communication
A malicious third party may intentionally intercept wireless communications and see their 
contents, including possibly:

 - Personal information such as IDs, passwords, and credit card numbers
 - The contents of email messages

• Unauthorized access
A malicious third party may access the individual's or company's internal network without 
permission and carry out actions such as the following:

 - Retrieve personal and/or secret information (information leak)
 - Spread false information by impersonating a particular person (spoofing)
 - Overwrite intercepted communications and issue false data (tampering)
 - Spread harmful software such as a computer virus and crash your data and/or system 
(system crash)

 Since most wireless LAN cards or access points are equipped with security features to 
take care of these problems, you can reduce the possibility of these problems occurring 
when using this product by making the appropriate security settings for the wireless LAN 
device.

 Some wireless LAN devices may not be set for security immediately after purchase. To 
decrease the possibility of occurrence of security problems, before using any wireless LAN 
devices, be absolutely sure to make all security-related settings according to the instructions 
given in the operation manuals supplied with them.
 Depending on the specifications of the wireless LAN, a malicious third-party may be able 
to break security settings by special means.

 Please contact your dealer if you need help taking care of security settings or other such.

 Panasonic Projector & Display Corporation asks customers to thoroughly understand 
the risk of using this product without making security settings, and recommends that the 
customer make security settings at their own discretion and responsibility.
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About this document
• Although a tablet can be used instead of a computer for the client function, the descriptions in 

the operating instructions assume the use of a desktop computer.
• Depending on your environment and settings, your screen may not match the screens shown 

in the operating instructions.
• For information about the operation of your computer, Windows operating system and the 

various routers, please see their respective instruction manuals.
• In this document, “(page X)” indicates a page to be referenced.
• The contents of this document are subject to change without prior notice.
• Unauthorized reproduction of the contents of this document in whole or in part is prohibited.
• Names of menus, tabs, buttons and strings in screens are given in square brackets ([ ]).
• Arrows (→) are used to indicate selection of a submenu from a higher-level menu.
• There is no categorization between a user account and administrator account for a Panasonic 

Projector & Display Corporation's Media Processor FMP Series account. The set account can 
be used as an administrator account.

Terms used in this document

Device
“Device” refers to a Panasonic display device (projector or flat panel display).

Peripheral device
“Peripheral device” refers to a network camera or media processor connected to the same 
network as a device. You can check the images of a registered network camera.

DHCP (Dynamic Host Configuration Protocol) server
A server that automatically issues an IP address and other required information to a computer 
that is temporarily connected to the network.

PASS
The Panasonic Professional Display and Projector Technical Support Website.
For details, please visit the following websites.
https://docs.connect.panasonic.com/projector/pass
https://docs.connect.panasonic.com/prodisplays/pass

SNMP (Simple Network Management Protocol)
A protocol for monitoring and controlling communication equipment connected to the TCP/
IP network over the network. SNMP consists of an SNMP manager on the management side 
and SNMP agents on the managed side. A notification sent from an SNMP agent to an SNMP 
manager is called an “SNMP trap”. 
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What You can do with this Software
The purpose of this software is to centrally manage the equipment located in a particular 
network, for example in a school or company. The software makes it possible to monitor and 
display the status of multiple devices and their peripheral devices on the intranet and to issue 
error notifications.

Monitoring / Control Terminal*1

E-Mail transmissions

SNMP trap  
transmissions

SNMP manager

Mail server
Peripheral devices

Device

Monitoring / Control

*1 The computer on which this software (Multi Monitoring & Control Software) is installed.

Notes
• Please note that the software cannot predict the breakdown of devices and their peripheral devices in 

all instances. Also, the details displayed in an error notification will differ depending on the device or 
peripheral device.

• For the devices and peripheral devices compatible with this software, please check this application 
software which is posted on the following website.  
https://docs.connect.panasonic.com/projector/download/application 
https://docs.connect.panasonic.com/prodisplays/download/software



9

Introduction

What You can do with this Software

Monitoring and control functions
This section describes the main functions that are carried out from the monitoring and control 
terminal.

 ■Registering and updating devices
Register device (page 24)
You can register devices that have been connected to the intranet. (Maximum of 2,048)
• Add a new device (page 24)
• Update registered information (page 36)
• Register peripheral device 

 - Network camera (page 38)
• Create group (page 44)
• Create keyword (page 46)
• Create brightness control for a group (page 49)

Update firmware (page 68)
Simultaneous multiple device updates can be done onto the firmware of a registered device 
using a firmware update tool.

Update device information (page 52)
If the IP address of a connected device is being used by another registered device, an icon 
appears indicating that the device was not recognized due to a mismatch with the registered 
information. In this case, you may continue to use the device by updating its registration 
information.

Manage location information (Map UI) (page 56)
You can manage the placement of devices on a per-group basis.
• Control device (page 59)
• Register schedule (page 59)

 ■Confirming the status of devices and peripheral devices
Monitoring (page 60)
You can display and monitor the status of devices and peripheral devices.
• Brief information display (page 60)
• Detailed information display (page 72)
• Network camera image display (page 74)
• Display an image input into a device (page 76)
• Error display (page 79)
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What You can do with this Software

Linking with other application softwares
You can call up installed applications from this software.
• Geometry Manager Pro (page 32, 138)
• Exporting for Screen Transfer (page 34)
• Exporting for Smart Projector Control App (page 34)
• Web Control Function (page 135)
• Setting screen of the network camera body (page 74)

 ■Controlling devices
Execute control command (page 92)
You can control multiple devices at once (power off/on, input switching, etc.).

Scheduling function (page 102)
The following functions can be executed at a specified date and time.
• [Operation Settings] (page 105)
• [Command Settings] (page 106)
• [Command list Settings] (page 108)
• [Distribute captions] (page 114)
• [Stop caption distribution] (page 116)
• [Brightness Control] (page 118)
• [Delivering contents list] (page 121)

 ■Monitoring item settings (on the monitoring and control terminal)

SNMP trap transmissions (page 151)
Informs the SNMP manager (network device management software) of errors, warnings and 
notifications by sending an SNMP trap (when they occur or are cleared).

Mail send function (page 154)
Sends information on errors, warnings and notifications to a preset mail address.

Set a warning to report that a device is not connected (page 158)
Set the conditions for issuing a warning to report that a device is not connected, or specify time 
periods during which disconnection warnings will not be output.
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System Requirements
 ■Software Operating Environment

The computer that will be used as a monitoring and control terminal and where the software will 
be installed must meet the following requirements.

OS
(Operating system)

Windows 11: Windows 11 Pro (64 bit)
Windows 10: Windows 10 Pro (32 bit/64 bit)
Windows Server 2016: Standard (32 bit/64 bit)

• The software works in 32-bit mode on 64-bit Windows.
• Compatible with English, Japanese or Chinese language versions of the 

above operating systems. 
• Microsoft Internet Information Services (IIS) is automatically enabled when 

the software is installed.

Software library Microsoft .NET Framework 4.8
• Enable the installed .NET Framework 4.8 function. (page 16)

Web browser
Microsoft Edge
• The software should operate in most web browsers, excluding those above, 

but correct operation is not guaranteed.

CPU
Intel® Core™ 2 Duo or better, or equivalent processor
• Intel® Core™ i5 or higher processors are recommended when the number of 

connected devices is 65 or more.

Memory 8,192 MB or higher

Hard disk free space
100 GB or more
• Required capacity increases with increasing number of units.  

(Roughly 50 MB per unit.)

Other details LAN connector (10Base-T/100Base-TX)
A display with a resolution of 1,366 × 768, High Color (16-bit) or better

Note that this does not guarantee that any computer satisfying the above requirements 
will be able to run the software.

Notes
• When using the Windows Server 2016 terminal, operating it as a server is recommended.
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Network Configuration
The following sections describe how to connect a monitoring and control terminal, and devices 
and their peripheral devices via a network connection.

 ■Necessary Environment for Computers to be Connected
Confirm that the following LAN configuration is in place before connecting the computer to the 
intranet.

Computer with a built-in LAN function
• Is your LAN switched on?

Computer without a built-in LAN function
• Is your LAN adapter properly recognized?
• Is your LAN adapter switched on?
• Install the required driver for the LAN adapter before making a connection. Install the driver 

according to the instructions in the operating instructions supplied with the LAN adapter.

Notes
• The monitoring and control terminal should be set to a unique, fixed address on the network, without 

obtaining an IP address automatically from a DHCP server.
• Installation of security features such as firewalls or LAN adapter utilities may prevent the software from 

establishing a connection to an intranet. Consult the administrative user if a connection cannot be 
established.

• There is no guarantee that the software will work with any LAN adapter or any computer with a built-in 
LAN adapter.

 ■Setting the Computer
Please use a crossing cable to connect the computer and device when it is directly connected to 
the LAN outside the intranet.
Use a straight cable for the connection when a hub or other device is used to connect the 
computer and device.

Network Setup
• Set the IP ADDRESS, SUBNET MASK and DEFAULT GATEWAY according to the operating 

environment. (Please consult your network administrator for details.)
• If “Use automatic configuration script” is checked in your web browser, uncheck it.
• If “Use a proxy server for your LAN” is checked in your web browser, uncheck it or specify the 

device IP address in “Exceptions” in the advanced proxy settings.

Notes
• Depending on the system configuration, whether it is straight, cross, or both to be used, will differ. 

Please consult your network administrator for details.
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Network Configuration

 ■Setting the Device
Network Setup
Set the HOST NAME (DEVICE NAME), IP ADDRESS, SUBNET MASK, and DEFAULT 
GATEWAY according to the operating environment. (Please check with your network 
administrator for details.)
Set DHCP to OFF and set a fixed IP address, making sure that the entered IP address is not 
used by any other device on the LAN.
If the entered IP address is used by another device, the device cannot be registered.
• For models that can be set, enable WEB control, PJLink Control, Network Control, and 

Network Standby.
• For devices that need to set an administrator account, perform the settings of the 

administrator account. 
• For models in which the Web port number can be set, set the port number to “80”.
• For models in which command control can be set, set the port number to the same number. 

(Default setting value: 1024)

Flat-Panel Display Settings
When registering a flat-panel display that belongs to the Rich information model group to the 
software, various settings on the display itself must be configured.
When registering a flat-panel display that belongs to the Basic information model group to the 
software, settings configuration on the display itself is not required.
To see which group the device to be registered belongs to, see page 20.
• Change the [Options] menu of the flat panel display unit as follows.

[LAN Control Protocol] Set to [Protocol 2].

[RS-232C/LAN Information Timing]
or
[Information timing]

Set the conditions for the detection of warnings and errors.

Notes
• For how to set a device or peripheral device, check the operation manual of the device or peripheral 

device you are using.
• This software identifies the device using the configured IP address. If DHCP is set to ON in the device 

network setting in a network environment that uses a DHCP server etc. the DHCP server may change 
the IP address allocated to the device, making it impossible to connect using this software. Please 
ensure that the server does not change the IP address by, for example, setting the DHCP server so as 
to fix the IP address allocated to the device. (Consult your network administrator for details.)

• If a flat-panel display registered as a Rich information model automatically switches to the standby 
state during monitoring due to activation of the “No activity power off” function or other reasons, a 
warning is issued. To prevent warnings from being issued, it is necessary to change the configuration 
of the display so that it does not switch automatically to a standby state.  
If a flat-panel display registered as a Basic information model automatically switches to the standby 
state, a warning will not be issued.

• Configure the current time and on-screen menu language settings on a flat-panel display registered as 
a Rich information model if the settings are available.  
A warning may be issued if the display is used without configuring these items. If a flat-panel display 
is registered as a Basic information model, a warning will not occur even if you do not set the current 
time or select an on-screen menu language.
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Steps to Start Operation
The steps from software installation to start of operation are listed below.

Installing the software

1 Downloading the installation file (page 15)

2 Installing the software (page 15)

Computer with 
Internet connection

Monitoring and 
control terminal

Setup.msi
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Installing the Software on the Monitoring and 
Control Terminal

If you are using a previous version of the “Multi Monitoring & Control Software”, you can 
continue using your existing data as-is by following the installation procedure below.

Downloading the installation file
1 You can download the installation file from the following websites.

https://docs.connect.panasonic.com/projector/download/application
https://docs.connect.panasonic.com/prodisplays/download/software

2 The terms for the application software download will appear. After reading them, 
click [Agree].
File name: MMCS_V4xxx_Setup.zip (where “4xxx” is the software version).

Notes
• If the version of the software is not compatible with your devices, some device information may not be 

displayed. Please download the latest software.

Installing the software
Install the software on the monitoring and control terminal.

Preparation:
• Make sure the Windows Update program is up to date.
• Verify that .NET Framework 4.8 is installed on your computer and that the .NET Framework 

4.8 function is enabled.
• Close all programs that are running on Windows.
1 Extract the file “MMCS_V4xxx_Setup.zip” after it has finished downloading.

2 Double click “Setup.msi” in the folder created during extraction.
The installer will start.

3 Follow the instructions on the screen to complete the installation.
When the installation completes, the completion screen appears.

4 Click [Close].
The shortcut icon  will appear on the desktop.



16

Preparation

Installing the Software on the Monitoring and Control Terminal

 ■The following message will appear during installation

[Yes]: Continue installation.
[No]: Abort the installation.

• For details about your computer settings and network environment, consult your network 
administrator.

Notes
• The installation may terminate unsuccessfully if you attempt to install the software while Windows 

Update is running or if the PC is in a state that requires it to be restarted.
• When using the software for the first time on a computer, always run Windows Update to install any 

required updates before using the software. The software may not operate if you attempt to use the 
software without running Windows Update.

• If .NET Framework 4.8 is not installed or the function is not enabled, an error will occur during 
installation of the software. In such cases, click [No] to cancel installation of the software, and enable 
the .NET Framework 4.8 function before performing installation again. See “Cannot install the 
software” in the “Frequently Asked Questions” section. (page 169)

• The update installer may take some time if there are many registered devices when performing the 
update installing. For example, if there are more than 513 devices registered, installation may take 
about ten minutes on a computer with 4 GB of memory.
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Installing the Software on the Monitoring and Control Terminal

Repairing or removing the software
If you run the installer again on the monitor and control terminal when this software has already 
been installed, a screen asking if you want to repair or remove the software appears.

1 In step 3 of “Installing the software” (page 15), select whether you 
want to “Repair” or “Remove” the software, and then click [Finish].
Repair: Repair defects in the software
Remove: Uninstall the software and reinstall it

(When “Repair” is selected)

2 Follow the instructions on the screen to continue the installation.
When the installation completes, the completion screen appears.

3 Click [Close].
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Installing the Software on the Monitoring and Control Terminal

Starting the software

1 Double-click  on the desktop to start it.
You can also start the software by selecting [Start] → [Panasonic] → [Multi Monitoring & 
Control Software].

Confirming the software version
1 Select [About] → [Version] from the menu.

2 After checking the version, click [Close] to close the screen.
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Installing the Software on the Monitoring and Control Terminal

Exiting the software

1 Click  on the screen.
• You can also exit by choosing [Device Management] → [Exit] from the menu.
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Before Using this Software
Checking whether devices are supported

For the devices and peripheral devices compatible with this software, please visit the following 
websites.
https://docs.connect.panasonic.com/projector/download/application
https://docs.connect.panasonic.com/prodisplays/download/software

Devices are categorized into one of two groups depending on the type of information that can 
be accessed from them by the software. The difference in the type of information that can be 
accessed for “Rich information model” and “Basic information model” is as follows.

○: Accessible
–: Not accessible

Item name
Group designation based on accessible 

information
Rich information model Basic information model

Common items
Group Name ○ ○
IP Address ○ ○
Shutter (AV Mute) ○ ○
Model Name ○ ○
Serial Number ○ –
Selected input ○ ○
Power ○ ○
Source Name ○ –
Signal Freq. ○ –
Main/Sub Version ○ –
Network Version ○ –
AC Voltage ○ –
Power on hours ○ ○ 
Temperature ○ –
Fan status ○ –

Projector only
Selected LIGHT ○ –
LIGHT Power / Operating Mode ○ –
LIGHT status ○ ○

Notes
• May not be accessible depending on the device even if it is described as accessible in the table.
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Uninstalling the software
1 Follow these steps to open the [Apps & features] window.

Click  → [  Settings].
Select [Apps] on Windows Settings.
Select [Multi Monitoring and Control Software], and click [Uninstall].

2 When the confirmation message appears, select [Yes] or [No].
[Yes]: Delete the registered device data and uninstall the software.
[No]: Uninstall the software but preserve the registered device data.
• If you select [No], you can continue to use the preserved data after installing this software 

again or after upgrading the software.
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About the <Device Monitoring> Window

<Device Monitoring> window

Menu

Functions are arranged as individual menu items.
[Create New Device] (page 24) 
[Device Management]:  Device management menu excluding 

the registration of devices and peripheral 
devices.

[Control] (page 92) 
[Options] (page 104, 142)
[View] (page 23) 
[About] (page 18) 

Screen switching tabs

[Device Monitoring] (page 60)
[Monitor on Map] (page 56)
[Camera View] (page 75)
[Remote Preview] (page 77)
[Simple System history] (page 79)
[Monitoring Settings] (page 150)
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About the <Device Monitoring> Window

Tree pane

[Group]:  A parent group ([Group] folder) 
This is the folder that the tree is composed from. 

: Group folder (page 44)

: Network camera  (page 38)

: Projector (Rich information model)

: Flat panel display (Rich information model)

: Illumination-type projector (Rich information model)

: Basic information model device

[Keyword]: The keyword created will be displayed. (page 46)
[BrightnessControl]:  The brightness control created will be 

displayed. (page 49)
• Register devices directly under the parent group ([Group] folder) 

or under a group folder or network camera. (page 24)

Brief information display pane

Lists the status of the devices selected in the tree pane ( ).  
(When a folder is selected, multiple lines of information are 
displayed.)
• When “  ” is displayed when an item of the list is selected, you 

can display it by descending order or ascending order.

Command execution log pane
Displays the execution results of the control command (page 92) 
or scheduling function (page 102) and the connection status of 
the device.

Valid thru display area Displays the valid thru information.

Status bar
Displays the status of this software.
• You can select whether or not to display from the menu’s ( ) 

[View] → [Status Bar].

Notes
• Refer to the following about warnings or errors (Example: , ) displayed on the icon.

 - Tree pane (page 61)
 - Brief information display pane (page 62)

• For details about “Rich information model” and “Basic information model”, see page 20.
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Registering Devices and Peripheral Devices to 
Monitor and Control

Up to 2,048 devices can be registered. There are several registration methods to choose from 
depending on your environment.

[Individual Registration of Device] Register devices manually (page 24)

[Auto Search of Device] Search and register connected devices (page 27)

[File(.csv) Registration of Device] Register devices by importing a file (page 30)

[Geometry Manager Pro] Register devices by importing an external setup file (Geometry 
Manager Pro) (page 32)

[Network camera registration] Register a network camera (page 38)

Notes
• The monitoring and control terminal cannot register devices when it is communicating with a device. 

Register at another time.
• When registering a flat-panel display that belongs to the Rich information model group, set [LAN 

Control Protocol] to [Protocol 2]. (page 13)
• The same peripheral device can also be registered to multiple devices.
• After registering a device, if you change the [User Name] or [Password] of the administrator account or 

the [Password] of the PJLink of the device that is used with the WEB control function, the device will 
no longer be able to communicate and will need to be re-registered.

Registering devices manually
1 Select [Create New Device] → [Individual Registration of Device] from the 

menu.
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Registering Devices and Peripheral Devices to Monitor and Control

2 Enter the [IP Address], [User Name], and [Password] stored in the device 
you want to register.

[IP Address]
Carefully enter the IP address assigned to the device you want to register.
• You cannot register the same IP address to multiple devices. If 

you want to register an individual device using an IP address 
that has already been assigned, see page 52.

Administrator account

[User Name]

Carefully enter the user name that was configured on the device 
you want to register.
Basic information model: Registration is possible without entering 
a name.
Rich information model:  If you enter a user name that does not 

match the name stored on the device, 
registration will not be possible.

[Password] Carefully enter the password that was configured on the device 
you want to register.

PJLink [Password] Carefully enter the password that was configured on the device 
you want to register.

[Enable error notification 
from device]

You can select or deselect this check box to set the error 
notification function of the device you want to register.
• The status notification function needs to be set to receive error 

notifications from devices. To set the status notification function, 
see page 147.

• For an unsupported model, an error message is displayed.

• When you click  displayed on the right side of the password input field, it switches 
between displaying and hiding the input content.

• Up to 512 characters may be entered into the fields [Memo1] and [Memo2]. Enter any 
comment you may want to add.

• Click [Close] to stop the device registration.
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3 Click [Create] ( ).
• Devices in which an administrator account is not set, cannot be registered. Set the 

administrator account of the device, and then click [Create] ( ).
• Click [Close] if you decide not to perform the registration.

4 When the “registration successful” message appears, click [OK]. 

5 Click [Close] ( ).
The registered device will appear in the tree pane on the <Device Monitoring> window. 
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Registering connected devices by Auto Search
1 Select [Create New Device] → [Auto Search of Device] from the menu.

2 Enter the following items regarding the device to be registered. 
 - [User Name] and [Password] of the administrator account
 - [Password] of the PJLink

• For more information about the [User Name] and [Password], see page 25.
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3 Choose a search method ( ) and click [Start search] ( ).

[Auto search (local network)]:  Find registerable devices that are connected on the same 
network as the monitoring and control terminal.

[Address range specification]: Search the specified IP address range.

The search results are displayed in .
• When devices in which an administrator account is not set is detected and displayed in 

the search results, [Detected device(Not set password)] ( ) will be enabled. When setting 
an administrator account, refer to page 29.

4 In the search results ( ), select the leftmost check boxes of the devices 
to be registered.

5 Click [Create] ( ).
The registered devices will appear in the tree pane on the <Device Monitoring> window.
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 ■When an administrator account is not set
1 Click [Detected device(Not set password)] ( ) (page 28).

The detected devices will be displayed as a list

2 Confirm the IP Address and click [WEB].
When the setting window of the device is displayed on the web browser, perform network 
settings.

3 When the network settings are completed, return to the screen of step 2, and 
then click [Close] ( ).
It will return to the [Auto Device Registration] screen of step 3 on page 28.

4 Click [Start search] ( ) on the [Auto Device Registration] screen, and continue 
to perform steps 4 and 5 of page 28.

Notes
• Searching and registering devices may take a long time.
• Depending on the state of the devices and the network environment, it may not be possible to 

recognize devices using the search function.
• Devices that can be searched for with [Auto search (local network)] are limited to those supporting 

the proprietary command for search. To see if a device being used supports the [Auto search (local 
network)] function, refer to the “List of Compatible Device Models” of this application software which is 
posted on the following website. 
https://docs.connect.panasonic.com/projector/download/application 
https://docs.connect.panasonic.com/prodisplays/download/software
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Registering devices by importing a file
1 Select [Create New Device] → [File(.csv) Registration of Device] from the 

menu.

2 Select the CSV file that stores the information on the devices to be 
registered, and click [Open].
• A CSV file is a text file in which the fields are separated by commas. The CSV files used 

in this software are written in the format “IP address, user name, password, PJLink 
password”, with one device represented per line.
Example:
192.168.0.8,User name1,Password1,PJLinkPassword1 [line break]
192.168.0.9,User name2,Password2,PJLinkPassword2 [line break]

·
·
·
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3 Place a check on the check box on the left side of the device you want to 
register.

4 Click [Create] ( ).
The registered devices will appear in the tree pane on the <Device Monitoring> window.

Notes
• Displaying the registered device information may take a long time.
• The passwords will be hidden behind asterisk characters (***).
• Device files including devices that use a comma (,) in the user name or password cannot be imported. 

When registering devices that use a comma (,) in the user name or password, please register 
manually. (page 24)
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Registering from “Geometry Manager Pro”
This function is used to register in this software the setup information of the projectors 
registered in “Geometry Manager Pro” which is a software application that supports the 
geometry correction and installation adjustments of the projectors.
It is useful at such times when there are a large number of projectors to be registered because it 
obviates the need to register the projectors again using this software.

1 Select [Device Management] → [Importing an external setup file]  
→ [Geometry Manager Pro] from the menu.

2 The message [The device with the same IP Address cannot be registered. 
OK?] is displayed.
[Yes]:  If the IP address of the projector to be imported matches the IP address of a 

registered device, the projector will not be registered.
[No]: Cancel the import process.

3 Click [Select file].
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4 Select the projector registration information file (extension: .ugk) and 
click [Open].

5 When the import results are displayed, check the contents and click [OK].
• If importing has failed because the file is damaged, for instance, the message is 

displayed. Check whether there is problem in the projector registration information file.
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Export device information

 ■Exporting device information for Screen Transfer
It is a function that exports registered device information for Screen Transfer.

1 Select [Device Management] → [Export of Registered device] →  
[Screen Transfer] from the menu.
If you select menu after selecting  (group folder) or  (network camera) at the tree 
pane of the <Device Monitoring> window, you can only export the device information under 
the selected group.

2 Set the save destination and file name, and click [Save].
File name: DeviceList.dat

 ■Exporting projector information for Smart Projector Control App linking
It is a function that only extracts projectors from registered devices, and exports related 
information for Smart Projector Control App linking.

1 Select [Device Management] → [Export of Registered device] →  
[Smart Projector Control App] from the menu.
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2 Select the check box of the projector or  (group folder) you want to 
export, and click [Export].

3 Set the save destination and file name, and click [Save].
When the message of successful saving is displayed, click [OK].
File name: MMCS_DeviceList_XXXXXXXXXXXXXX.dat  
(“XXXXXXXXXXXXXX” is the year, month, day, hour, minute, and second.)
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Changing the Registration Information of a Device 
or Peripheral Device

1 From the tree pane on the <Device Monitoring> window, select the device 
whose registration information is to be changed, right-click it, and select 
[Property].

2 Change the registered information and click [Update] ( ).

3 Click [Close] ( ).
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You can change the registered device name.

1 From the tree pane on the <Device Monitoring> window, select the device 
name you want to change, and press the [F2] key on the keyboard.
• Alternatively, you can use the following method.

 - Select the device name you want to change, and click on the device name once again.

2 Enter a new device name, and press the [Enter] key.
You can enter up to 8 half-width upper-case letters or numerals for a flat panel display and 
up to 12 for a projector.

Notes
• If you change the device name on the software side, the device name on the device side will also be 

changed. For devices that does not support the change device name function, the device name will 
change back even if you change the device name.
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Register a network camera
You can individually register a network camera as a peripheral device. (Maximum of 32)
• To link a registered network camera to devices or group folders, see page 40.

1 Select [Create New Device] → [Network camera registration] from the 
menu.

2 Enter the set [IP Address], [User Name], and [Password] of the network 
camera you will register.
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3 Enter [Network camera Name] and [Memo] as necessary then click 
[Create].
[Network camera Name]: You can enter a maximum of 32 characters.
[Memo]: You can enter a maximum of 512 characters.

4 Click [Close].
 and the [Network camera Name] (CAM-XXX (XXX: network camera’s IP address) will be 

displayed if not entered) entered in Step 3 will be displayed on the tree pane of the <Device 
Monitoring> window.
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Linking a device
By linking a registered network camera to a device or group folder, you can monitor devices with 
video.

 ■To link devices or group folders that are already registered

1 Drag the device icon or  (group folder) you want to link directly under  
and drop it. 
• When you move a group, the groups or devices under the group will also move together.
• Up to 99 hierarchical levels can be set for the groups.

 ■To create and link new devices and group folders
1 Select the  you want to link then right-click it and select [Create New Device] 

or [Create New Group].
For further steps, see the following pages.
• [Create New Device] (page 24)
• [Create New Group] (page 44)

Notes
• You cannot directly link a network camera to another network camera.
• To display a registered network camera’s video as an image, see page 74.
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Changing the Registration Information of a 
Network Camera

1 Select the  (network camera) of the registration information you will 
change then right-click it and select [Property] from the tree pane of the  
<Device Monitoring> window.

2 Change the registered information and click [Update] ( ).

3 Click [Close] ( ).
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Setting up the Fail Soft Function
If the video signal is momentarily interrupted, resulting in a continuing no-signal condition, the 
fail soft function on flat panel displays performs recovery processing automatically so that video 
continues to be displayed.
To enable the fail soft function, select one of the following.
[Enable hot plug reset processing.]:
The video signal is redetected for the selected input. (Normally, you would select this option.)
[Enable hot plug reset processing and power supply reset processing.]:
If recovery is not possible using hot plug reset processing, the device is powered off and then 
back on again. 

Notes
• Enabling the fail soft function is recommended in cases where video content is played continuously 

over an extended period of time, such as signage applications. This function will automatically attempt 
to recover if an unanticipated no-signal condition occurs.

• Do not use the fail soft function in usage situations where video content is not played continuously 
and sometimes there is no input signal. This software will display a notification each time automatic 
recovery processing occurs, whether or not it is necessary.

• If recovery from a no-signal condition often fails even when [Enable hot plug reset processing.] is 
selected, select [Enable hot plug reset processing and power supply reset processing.] instead.

• For flat panel displays that support the fail soft function. 
To see if a flat panel display being used is supported, refer to the “List of Compatible Device Models” 
of this application software which is posted on the following website. 
https://docs.connect.panasonic.com/prodisplays/download/software

1 From the tree pane on the <Device Monitoring> window, select the flat 
panel display to which the fail soft function is to be set, right-click it, and 
select [Property].
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2 Open the [Others] tab, and select functions  by checking them.
[Enable hot plug reset processing.]:
The video signal is redetected for the selected input. (Normally, you would select this 
option.)
[Enable hot plug reset processing and power supply reset processing.]:
If recovery is not possible using hot plug reset processing, the device is powered off and 
then back on again.

3 Click [Setting] ( ).
After changing settings, the following message is displayed. Click [OK].

4 Click [Close] ( ).

Notes
• The fail soft function is not guaranteed to prevent all situations in which video display stops.
• The fail soft function can be used when the video input signal being input to the flat panel display is a 

digital signal.
• The interval of the fail soft function is updated depends on the [Interval Time of Device Information] 

(page 143) setting.
Example)  If you set the [Interval Time of Device Information] to 60 minutes  

Even if the video connection momentarily cuts off and is in a no-signal condition, the 
software will not be able to recognize the momentary no-signal condition between the 
60 minutes the device information is being automatically retrieved till the next automatic 
retrieval.

• Enabling the fail soft function also requires making settings on the flat panel display.
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Creating a Group
Use the steps below to manage specific groups of devices, for example by floor or by type.
A total of 100 groups can be created.

1 Select  (group folder) from the tree pane on the <Device Monitoring> 
window, right-click it, and select [Create New Group].
• Alternatively, you can use the following method.

 - Select [Device Management] → [Create New Group] from the menu.

2 Enter a [Group Name].
You can enter up to 128 characters.
• [Memo] may be added if desired. You can enter up to 512 characters.

3 Click [OK].
A new group icon will be created in the tree pane.

Notes
• The same name may be used for more than one group.
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Moving a group

1 Drag the device icon and drop it under the  (group folder) where you want to 
register it.
• When you move a group, the groups or devices under the group will also move together.
• Up to 99 hierarchical levels can be set for the groups.

Moving registered devices to a different group

Moving by Group

Newly register a device under a group

1 Select the  (group folder) you want to register then right-click it and select 
[Create New Device] or [Create New Group].
For further steps, see the following pages.
• [Create New Device] (page 24)
• [Create New Group] (page 44)
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Creating a Keyword
You need to create the keyword first when you want to monitor and control the devices as a 
keyword unit.

1 Select [Device Management] → [Create New Keyword] from the menu.

2 Enter the [Keyword].
A character string of your choice of up to 128 single-byte characters may be used.
• [Memo] may be added if desired. You can enter up to 512 characters.

3 Click [OK].
A new keyword icon will be created in the tree pane.
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Assigning a Keyword to a Device
1 From the tree pane on the <Device Monitoring> window, select the device 

you want to assign a keyword to, right-click it, and select [Property].
• Alternatively, you can use the following method.

 - Select [Device Management] → [Property] from the menu.
 - Select the device in the Brief information display pane, right-click it, and select 
[Property] in the displayed menu.
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2 Open the [Property] tab, select the keyword you want to assign from 
[Keyword List], and click .
The selected keyword will move to the [Registered Keyword List] on the right side. If you 
click , it will return to the left side.
• In order to assign multiple keywords, repeat the process above for each keyword.

3 Click [Update] ( ).

4 When the “update successful” message appears, click [OK]. 

5 Click [Close] ( ).
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Creating Brightness Control
Brightness control can be registered to prevent the brightness on the projected screen from 
being inconsistent between each projector as a result of individual characteristics and time 
degradation of lamps when, for example, a group of projectors are used to display one 
integrated image.

1 Select [Device Management] → [Create Brightness Control] from the 
menu.

2 Enter a [Brightness Control Name].
A character string of your choice of up to 128 single-byte characters may be used.
• [Memo] may be added if desired. You can enter up to 512 characters.

3 Click [OK].
A new brightness control icon will be created in the tree pane.
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Assigning brightness control to a projector
1 From the tree pane on the <Device Monitoring> window, select the 

projector you want to assign a brightness control to, right-click it, and 
select [Property].
• Alternatively, you can use the following method.

 - Select [Device Management] → [Property] from the menu.
 - Select the projector displayed on the Brief Information Display, right-click it, and select 
[Property] from the displayed menu.

Notes
• The same brightness control cannot be assigned to projectors of different series. Assign a different 

brightness control to each projector series.
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2 Open the [Property] tab and select the brightness control you want to 
assign from [Brightness Control Setting].
The brightness controls that are already created will be listed. (page 49)

3 Click [Update] ( ).

4 When the “update successful” message appears, click [OK]. 

5 Click [Close] ( ).

Notes
• Assignment of brightness control is possible only for projectors equipped with a brightness control 

function. The pull-down menu will not appear for projectors without this function.
• To assign the brightness control, from the [MAIN MENU] of the projector’s onscreen menu → 

[PROJECTOR SETUP] → [Brightness Control] → [Brightness Control Setting] → [Mode] (or [Fixed 
Mode]) set to “PC”.

• The brightness control that has been assigned to a projector in a series different from that of the 
selected projector will not be displayed in [Brightness Control Setting].
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Updating Device Registration Information
If a device with a different model name from the registered device is detected such as when 
replacing the device already registered with this software with a device with the same IP 
address, administrator account (user name and password) and PJLink (password), the 
“Connected icon of a different model” is displayed in the Brief Information Display pane of the 
<Device Monitoring> window (page 60).

Connected icon of 
a different model

When registering a device with a different model name by replacing the previously registered 
device, perform the following procedure.

1 From the tree pane on the <Device Monitoring> window, select the device 
that is marked with the  icon, right-click it, and select  
[Update the device registration information].
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2 Check the user name, password, keyword setting, memo, etc., and if 
there is no problem, click [Update].

3 Click [Update] updates the device registration information. The message 
that is displayed differs in each of the cases of (a), (b), and (c).
(a) When the update is complete successfully

The following message appears if the updating of the registration information is 
successful.

(b) When a device to which brightness control is assigned is updated to a device that 
does not support brightness control, or the brightness control adjustment mode 
of the device to be updated is set to other than “PC” mode.
Then the following message is displayed.
Clicking [OK] updates the device registration information in the state where the device 
to be updated is excluded from the brightness control target.
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(c) When the update failed
When updating the registered information fails, the following message is displayed.
• Confirm the following settings of the device to be updated.

 - [User Name] and [Password] of the administrator account
 - [Password] of the PJLink

• When an administrator account is not set on a administrator account supported 
device, set an administrator account according to the warning message. (page 29)

Notes
• The group folder or keyword settings registered for the device will be transferred as-is after the update.
• The previously registered device schedule will be transferred as-is. If brightness control is released, 

then the schedule of brightness control is not taken over.
• If schedule for operation of a function not available with the updated device is taken over, then the 

function is not operated and results in error when the schedule is performed.
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Deleting (A device, group, keyword, brightness control, or network camera)

1 From the tree pane of the <Device Monitoring> window, select the icon of 
the device, group, keyword, brightness control, or network camera to be 
deleted, right-click it, and select [Delete].
• Alternatively, you can use the following method.

 - Select [Device Management] → [Delete] from the menu.
• When you select a folder, the folder and all its contents are deleted. (A parent group 

([Group] folder) cannot be deleted.)

2 When the confirmation message is displayed, click [Yes].
The selected item is deleted from the tree pane.
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Registering Device Location Information
You can arrange registered devices on the map in groups in order to visually check their 
installation status. You can also select devices from the map to carry out device control or 
schedule registration.

1 Open the [Monitor on Map] tab and select the [Group] tab to import the 
map.
All the existing groups including the parent group ([Group] folder) will be displayed in the tab.

2 Click [Specify Map Image] ( ) and select the map to import.
Select an image and click [Open] to import the image into the selected group.
• Selectable image files

 - Extension: .jpg/.jpeg/.png/.bmp
 - Maximum number of pixels: 4,096 × 4,096

• To switch the map, click [Specify Map Image] again and select another image. You can 
also switch images after the devices are installed.
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3 Drag and drop devices from the tree pane onto the map.
A list of the placed devices is displayed ( ).
• Click [Large] or [Small] ( ) to enlarge or reduce the size of the placed icons.
• Selecting the check box ( ) of a device icon on the map causes the corresponding check 

box in the [Select] column on the device list information side to be selected as well. (It is 
not possible to select check boxes in the device list information selection column directly.)

• Devices can be placed inside the registered group tab.
• Group folders can be placed in a registered group one level higher.
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Deleting a device or group folder that has been placed on a map
1 Select the device or group folder to delete, and drag and drop it onto the trash 

can ( ).
• To delete all devices or group folders all at once, click [Delete all] ( ).

2 When the confirmation message is displayed, click [Yes].
The device moved to the trash can will be deleted from the map.

Notes
• If you click [Delete Map image] ( ), the map image will disappear, but the placed devices and group 

folders will remain.
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Performing device control and scheduling from the map
1 Select the group tab where the devices to be configured were placed.

2 Select the check boxes of the devices and group folders to be configured 
and click [Control Command] ( ) or [Schedule] ( ).

3 (When [Control Command] is selected)
Follow the steps in “Executing a Control Command” (page 92) to 
configure the control settings.

(When [Schedule] is selected)
Follow the steps in “Scheduling Function” (page 102) to configure the 
schedule settings.
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About the Brief Information Display
The <Device Monitoring> window displays brief information relating to the registered devices as 
a Group/Keyword/Brightness Control unit.

<Device Monitoring> window
Tree pane (page 61)
Brief information display pane (page 62)
Command execution display pane:  Displays the execution results of the control command 

(page 92), scheduling function (page 102), 
connection status and the log history information of the 
devices.

Notes
• Regardless of the connection environment such as wired connection/wireless connection, when the 

communication environment is unstable, the device information may not be properly retrieved.
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Icons in the tree pane

Device

Device is in a normal status.

Device is in a warning status. (Details of warning are 
displayed in the Brief information display pane to be 
confirmed.)
Device is in an error status. (Details of errors are displayed 
in the Brief information display pane to be confirmed.)

Network camera
A network camera is registered.

An error has been detected with the connection of the 
network camera.

Group

A group has been made.

More than one device is in a warning status in the group.

More than one device is in an error status in the group.

Keyword A keyword has been made.

Brightness control

A brightness control has been created.

There are one or more projectors in the group for which 
brightness control failed to execute properly and a warning 
was detected.

Schedule A schedule has been set up to the device, group, keyword, 
or brightness control.

Notes
• When both a warning and an error are detected simultaneously from the same device, the error icon 

will be displayed. Also when a warning and an error occur simultaneously in the group, the icon is in 
indicated as an error.

• Depending on the flat panel display model, when a warning or error has occurred, or a new warning or  
error occurs, icons that indicate the warning or error will not appear in the tree pane on the <Device 
Monitoring> window and the normal status icon will be displayed instead. For details on the models for 
which this limitation applies, refer to the “List of Compatible Device Models” of this application software 
which is posted on the following website. 
https://docs.connect.panasonic.com/prodisplays/download/software 
You can view information on all device warnings or errors that have occurred under the [Self Test] item 
in the [Details] tab of the [Device Property] window. (page 72)
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Icons in the Brief information display
[Device Name]:Displays the projector name (host name) set for each device or displays the 

display name (host name) set for each flat panel display.
[Status]: Displays the status of the device as an icon.

 ■Status indication icons for the power, network connection, and shutter/AV 
mute

Device power is ON.

Device power is OFF (in standby status).

Device power is OFF and cooling down.

Device power is ON and warming up.

Device has been disconnected from the network.

The device connected to the network has the same IP address but different from the time 
of registration. The device needs to be updated. Execute the device registration information 
update. (page 52)

Shutter is open/device is in the audio and visual mute OFF status.

Shutter is closed/device is in the audio and visual mute ON status.

Shutter is open/device is in the audio mute ON status.

Shutter is closed/device is in the visual mute ON status.

 ■Warning indication icons
Lamp replacement time is near.
Please obtain a new lamp unit.
Intake temperature or exhaust temperature is high. 
Optics module temperature is high or low.
Check the ventilation and exhaust temperatures to ensure that the device is used within the 
operating temperature.
Filter clogged warning, low remaining ARF/ACF.
Please obtain a new ARF/ACF unit. Perform maintenance of the filter except for ARF/ACF.
All other warnings
Consult your retailer.
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 ■Error indication icons
Lamp replacement time is overdue, lamp/light source on failed, lamp is not installed, or lamp/
light source is malfunctioning.
Please exchange lamp if the replacement time is overdue. For other instances, consult your 
retailer.
Intake temperature, exhaust temperature or optics module temperature is high. 
Optics module temperature is low for a certain time duration.
Check the ventilation and exhaust temperatures to ensure that the device is used within the 
operating temperature.
Filter clogged error, ACR/ARF/ACF/air filter unit not installed, filter winding failed, or there is no 
remaining ARF/ACF.
If the remaining ARF/ACF is low, please replace the ARF/ACF unit.  
Perform maintenance or replacement of the filter except for ARF/ACF.  
Remove any foreign matter that is present.  
For other instances, consult your retailer.
All other errors (Lamp unit cover remaining open, fan error, shutter error, aperture error, color 
wheel error, ACR/ARF/ACF not installed, filter cleaning process time-out, DC voltage error, 
lens shift error, internal clock battery replacement is required, etc.)
Consult your retailer.

Notes
• When both a warning and an error are generated simultaneously, an error icon will be displayed.  

Refer to operating manual for the relevant device for how to respond to warnings and errors.
• Depending on the flat panel display model, when a warning or error has occurred, or a new warning 

or error occurs, icons that indicate the warning or error may not appear under [Status] in the brief 
information display pane. For details on the models for which this limitation applies, refer to the “List of 
Compatible Device Models” of this application software which is posted on the following website. 
https://docs.connect.panasonic.com/prodisplays/download/software 
You can view information on all device warnings or errors that have occurred under the [Self Test] item 
in the [Details] tab of the [Device Property] window. (page 72)
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 ■Other brief information
You can change the items to display from [Monitor Information] (page 149) from the setting 
window of option.
[Camera]: When you link a network camera with a device (page 40), an icon will be 

displayed.
When you click the icon, the network camera’s video will be displayed as an image.  
(page 74)
• When you click the [Camera View] tab, you can display the network camera’s video as an 

image all at once. (page 75)
The network camera is not linked to a device.

[Remote Preview]: An icon will be displayed when a device supports the remote preview 
function or remote preview lite function.

When you click the icon, the video input into the device will be displayed as an image.  
(page 76)
• When you click the [Remote Preview] tab, you can display the video input into the device 

as an image all at once. (page 77)
The device does not support the remote preview function or remote preview lite function.

[ECO setup level]:The icon is displayed when the device supports the ECO management 
function (page 137).

Green area increases when ECO setting items increase in the ECO management setting of 
the device.
The device does not support the ECO management function.
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[IP Address]: Displays the device’s IP address.
[Lamp/Light device 
Runtime]:

Displays the runtime for the lamp or light device with the longest 
runtime. (The time of the installed lamp/light source number is 
indicated as a tooltip.)

[Closed Caption]: Displays closed caption mode.
[Input]: Displays the selected input terminal information of the device.
[Source Signal]: Displays the current signal name of the device.
[Model Name]: Displays the device model name.
[Wireless Settings]: Displays the WIRELESS LAN connection method (SIMPLE, 

S-DIRECT, M-DIRECT, etc.) configured in the projector’s menu.
[Intake Air Temperature]: Displays the intake air temperature information of the projector.
[Optics Module 
Temperature]:

Displays the optics module temperature information of the 
projector.

[Around Air Temperature]: Displays the around air temperature information of the projector.
[OSD Setting]: Displays the OSD setting information of the projector.
[AC Voltage]: Displays the AC voltage information of the projector.
[Serial Number]: Displays the device serial number.
[Geometry]: Displays the setting information of the projector’s geometry 

correction.
[Board Temperature (FP)]: Displays the board temperature information of the flat panel 

display.
[Exhaust Temperature 
(FP)]:

Displays the exhaust temperature information of the flat panel 
display.

[Intake Temperature (FP)]: Displays the intake air temperature information of the flat panel 
display.

[Panel Temperature (FP)]: Displays the panel temperature information of the flat panel 
display.

Notes
• When “  ” is displayed when an item of the list is selected, you can display it by descending order or 

ascending order.
• Depending on the model, some information may not be obtained from the devices. Information that 

cannot be obtained is displayed as “---”.
• When using a projector whose lamp output can be set to Hi/Low (or normal/eco), the runtime when 

the lamp is set to Low is converted to an equivalent runtime when the lamp is set to High, and the 
corresponding total runtime is displayed.
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Update device information

 ■Updating automatically
The information in the <Device Monitoring> window is updated automatically according to the 
settings configured in “Setting the Information Updating Interval” (page 143).

 ■Updating manually
1 Select [Device Management] → [Update Information] from the menu.

• Alternatively, you can use the following method.
 - Press the [F5] button on the keyboard.

Information update is complete when the indication in the status bar of the <Device 
Monitoring> window (page 22) returns to [Ready], after it changes from [Ready] to 
[Updating Device Information.] and a progress bar appears on the right side.
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If the number of registered devices increases, then updating the information will take longer. 
If you wish to abort the update before completion, select [Device Management] → [Abort] 
from the menu.

The operation above changes the status bar on the <Device Monitoring> window (page 22) 
from [Updating Device Information.] to [Canceling…]. When the abort process is complete, 
the message on the status bar indicates [Ready].
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Update firmware of multiple devices simultaneously
Simultaneous multiple device updates can be done onto the firmware of a registered device.

Notes
• Currently (As of May 2024), only projectors are supported.
• To see if a device being used supports simultaneous multiple device firmware updates, refer to the 

“List of Compatible Device Models” of this application software which is posted on the following 
website. 
https://docs.connect.panasonic.com/projector/download/application

• When updating firmware, download the firmware update tool (Compressed file in zip format) 
compatible to the device you want to update from the following website. 
When you extract the compressed file that you have downloaded, an exe format execution file is 
generated. 
https://docs.connect.panasonic.com/projector/pass

1 From the tree pane on the <Device Monitoring> window, select a device or 
group then right-click it, and select [Firmware update].
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2 When the confirmation message is displayed, click [Yes].
• The firmware update is cancelled when [No] is selected.

3 When the device list is displayed, click the [Select] of the model you want to 
update.

4 Select the corresponding firmware update tool (exe format execution file), and 
click [Open].
File name:  FirmUpdateTool_Model name_Firmware version.exe 

Example)  For a PT-RZ17K model 
FirmUpdateTool_RZ24K_102.exe 
(An update tool for PT-RZ24K/PT-RZ17K/PT-RZ14K version 1.02)
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5 Click [Execute].

• The firmware update result will be displayed in the command execution log pane of the 
<Device Monitoring> window.

Device update is complete when the indication in the status bar of the <Device Monitoring> 
window (page 22) returns to [Ready], after it changes from [Ready] to [Updating the 
firmware.] and a progress bar appears on the right side.
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Notes
• After starting the firmware update, information update is stopped until the firmware update is complete.
• Simultaneous multiple device updates are executed onto target devices in increments of a 100 

devices. When the device you want to update exceeds a 100 devices, the update process is divided 
into multiple times for every 100 devices.

• If the firmware of the device is already the latest version, the update process of the corresponding 
device is not executed and the next device’s update process will proceed.

• If a firmware update tool that differs from the device you want to update is selected, the update 
process will not be executed.

• When a model that does not support simultaneous multiple updates or a different firmware update tool 
is selected, the corresponding model’s update process is not executed and the next model’s update 
process will proceed. If there is an unprocessed model, a [Failed to update the firmware.] message is 
displayed after all processes are completed. Check the device where [UPDATE NG] is displayed in the 
command execution log pane.
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1 From the tree pane on the <Device Monitoring> window, select the device 

whose detailed information you want to view, right-click it, and select 
[Property].
• Alternatively, you can use the following method.

 - Select [Device management] → [Property] from the menu.
 - Select the device in the Brief information display pane, right-click it, and select 
[Property] in the displayed menu.

2 Open the [Details] tab to view the detailed information.
• Click [Close] to complete the Detailed Information Display.
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Displayed items
The detailed information display shows the information listed in the table below.

Item Description

Device Name Device name

Manufacturer Manufacturer’s name

Model Name Model name

Power Power supply status

Shutter (AVMute) shutter control/AV mute

Input Input terminal

Source Signal Input signal

Lamp/Light device Power 
Lamp/Light device output 
(LIGHT Power / Operating 
Mode)

Lamp/Light device Power Lamp/Light device output

Lamp/Light device 1 Status Lamp/Light device 1 status

Lamp/Light device 1 Runtime Lamp/Light device 1  
operating time

Lamp/Light device 1 Remain Time Lamp/Light device 1 
remaining time

Lamp/Light device 2 Status Lamp/Light device 2 status

Lamp/Light device 2 Runtime Lamp/Light device 2  
operating time

Lamp/Light device 2 Remain Time Lamp/Light device 2 
remaining time

Lamp/Light device 3 Status Lamp/Light device 3 status

Lamp/Light device 3 Runtime Lamp/Light device 3  
operating time

Lamp/Light device 3 Remain Time Lamp/Light device 3 
remaining time

Lamp/Light device 4 Status Lamp/Light device 4 status

Lamp/Light device 4 Runtime Lamp/Light device 4  
operating time

Lamp/Light device 4 Remain Time Lamp/Light device 4 
remaining time

Intake Air Temperature Intake air temperature

Around Lamp/Light device 
Temperature

Around lamp/light device 
temperature (exhaust 
temperature)

Item Description

Optics Module Temperature Optics module temperature

Device Runtime Device operating time

Main Version Main microcomputer
Software version

Sub Version Sub microcomputer
Software version

Network Version Network microcomputer
Software version

Serial Number Serial number

Self Test Self-diagnosis results

Fan Status (FP) FAN rotation status

H Clock Horizontal frequency of input 
signal

V Clock Vertical frequency of input 
signal

Power Save Setting (FP) Power consumption reduction 
setting

Board Temperature (FP) Board temperature

Exhaust Temperature (FP) Exhaust temperature

Intake Air Temperature (FP) Intake air temperature

Panel Temperature (FP) Panel temperature

Light Device 1 Runtime Light device 1 operating time

Light Device 2 Runtime Light device 2 operating time

Light device Temperature 1 Light device temperature 1

Light device Temperature 2 Light device temperature 2

USB Memory Capacity USB memory capacity

AC Voltage AC voltage

Geometry Geometry correction settings

Notes
• Items indicated in the Detailed information display can be changed in the [Detailed Information] on the 

<Setting> window (page 149).
• If the content of a detailed information display item does not fit into its respective display area, you can 

display the content in its entirety as a tooltip by placing the mouse pointer on the [Item].
• In the Detailed information display, if a lamp life warning is detected, the remaining lamp time will turn 

yellow in the row for the problematic lamp. If a lamp life error is detected, it will turn red.
• Depending on the connected device, there may be some items that cannot be displayed. In this case, 

“---” is displayed.
• When using a projector whose lamp output can be set to Hi/Low (or normal/eco), the runtime when 

the lamp is set to Low is converted to an equivalent runtime when the lamp is set to High, and the 
corresponding total runtime is displayed.
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You can display the video of a registered network camera as an image.

Notes
• For details on registering a network camera, see the following pages.

 - Register a network camera (page 38)
 - Linking a network camera and device (page 40)

 ■Selecting a linked device and displaying it
Preparation:
• Display the [Camera] item in the brief information display. (page 149)

1 Select  (Network camera) or an icon of a device linked to a network camera 
or group from the <Device Monitoring> window.

2 Click  on the brief information display.
A network camera image will be displayed.
• If the network camera and device is not linked, it will be displayed as “ -- “.
• If an image was not able to be retrieved, a [Not able to get image from the device.] 

message will be displayed.
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 ■Display all at once
1 Click the [Camera View] tab in the <Device Monitoring> window.

• The camera monitoring window will be displayed.

Update button
The image display area will be updated to the latest state. 
(Automatic update interval: 5 seconds)
Camera setting button
You can display the setting window of the network camera.
• It may be required to install the necessary plug-in software to display the setting window of 

the network camera depending on your environment. Follow the on-screen instructions and 
install the plug-in software.

• If you cannot install the plug-in software, use the Web browser of the computer being used, 
and display the setting window of the network camera.

Image display area
All registered network camera images will be displayed.
• The device image selected from the tree pane will be indicated by a yellow box.
• If a problem has occurred, a [Not able to get image from the device.] message and the 

icons below will be displayed.
 -  (Error): The camera is not connected to the network.
 -  (Warning): It is connected to the network, but the image was not able to be retrieved.

Page switching button/Page number
If the images in the display area do not fit in 1 page, click   and move the page.
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Display the image input into the device
Displays the video input into the device that supports the remote preview function or remote 
preview lite function as an image.

Notes
• To see if the device you are using supports the remote preview function or remote preview lite 

function, refer to the “List of Compatible Device Models” of this application software which is posted on 
the following websites. 
https://docs.connect.panasonic.com/projector/download/application 
https://docs.connect.panasonic.com/prodisplays/download/software

 ■Select a device and display it
Preparation:
• Display the [Remote Preview] item in the brief information display. (page 149)
1 Select a device icon that supports the remote preview function or remote 

preview lite function from the tree pane of the <Device Monitoring> window.

2 Click  on the brief information display.
The video input into the device will be shown as an image.
• “--” is displayed for devices that do not support the remote preview function or remote 

preview lite function.
• If an image was not able to be retrieved, a [Not able to get image from the device.] 

message will be displayed.
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 ■Display all at once
1 Click the [Remote Preview] tab in the <Device Monitoring> window.

• The remote preview window will be displayed.

Update button
The image display area will be updated to the latest state. 
• The image may not be updated depending on the device operating status. Wait for a while 

(about 5 seconds), and click the update button again.
Enlarge/Reduce button
Enlarge or reduce the size of the selected image (yellow box) in 5 levels.
• You can switch the image size width in 5 levels from 200 x 150 to 400 x 300.
• You can also change it by scrolling with your mouse.
Image display area
The video input into the device will be shown as an image.
• The device image selected from the tree pane will be indicated by a yellow box.
• If you drag the selected thumbnail, you can move (Change the layout) thumbnail within the 

image display area.
• In addition to images, the following messages may be displayed.

 - [Not able to get image from the device.]: When the image cannot be retrieved.
 - [Preview aspect ratio is different from the projected image.]: When settings, such as 
display mode, have been changed on the device.

 - [Displaying test pattern]: When the test pattern is displayed on the device.
 - [It is starting up.]: When the device is powered on, and starting up.
 - [No signal is input.]: When no signal is input to the device.
 - [Can not be displayed due to copyright protection.]: When a video protected by digital 
rights management is input on the device.

 - [Images can not be displayed because the device settings are HTTPS settings.]: When 
the HTTPS setting is enabled on the device.

Page switching button/Page number
If the images in the display area do not fit in 1 page, click   and move the page.
Device information display area
The device status and video input information will be displayed.
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Notes
• The update interval of the actual on-screen display is heavily affected by the network environment, the 

computer’s capabilities, and the number of devices registered etc. 
• If there is a “COMMAND PROTECT” on the menu of the device, enable that setting then use it. When 

the setting is disabled, images may not display on the image display area of the remote preview 
window.  
For details on the “COMMAND PROTECT” menu, refer to the instruction manual of the device you are 
using.
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1 Click the [Simple System history] tab.

You can display the system history information in a table format.
• The information displayed is the system history for the number of items that correspond to 

[System log entry save count] in the [Options] → [Settings] → [General] tab of the menu. 
(page 144)

Simple system history information display area
Displays the following fields from the detected system history information.
[Checked Time]* Displays the date and time when the warning and error were detected.

[Group]*
Displays the group name which target device belongs. (If the group folder 
of the tree pane is , the camera name set at the time of network camera 
registration or CAM-XXX (XXX: network camera’s IP address) will be 
displayed as the group name.)

[Device Name]* Displays the target device name (or host name).
[IP Address]* Displays the device’s IP address.
[Model Name]* Displays the device model name.
[Serial Number]* Displays the serial number of a device.

[Status] Displays the status that occurred on the device as an icon.
For detailed information on the icons, see the Brief information display (page 60).

[Details] Displays the contents of the notification.

* : You can display it by descending order or ascending order.
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Notes
• You can view information on the device warnings or errors that have occurred under the [Self Test] 

item in the [Details] tab of the [Device Property] window. (page 72)
• The warning information and error information are not displayed on [Self Test] even when warning or 

error icon is displayed on [Status] of the simple system history screen of the flat panel display. Check 
with the device.

• Depending on the flat panel display, the warning or error icon may not be displayed on [Status] of the 
simple system history screen even when a warning or error occurs.

• When multiple error warnings occur at the same time, the same icon may appear more than once in 
[Status].

• If you want to check the details of the system history information, select [Device Management] → 
[Save simple system log] and check the output file that is saved (page 80).

Saving the Simple System History Information
Perform the following procedure to output the simple system history information to a file.

1 Select [Device Management] → [Save simple system log] from the menu.

2 Set the save destination and file name, and click [Save].
The simplified system history is saved as csv format. You can see the information with Text 
Editor and Microsoft Excel.
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 ■Example showing saved data
The simple system history file describes as following.

Software name
Version
File save date and time
Description items: Device name 

Manufacturer’s name
Model name
IP Address
Serial number
Date and Time when error generation was detected
Error status (6 digits)
Contents of error
Detailed error information
Self-diagnosis information (16, 32 or 64 digits: depending on model)

File end indication
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You can save the log information containing the operating status of the device being monitored 
or controlled by this software in the form of files.
When a problem occurs, you can give these log files to the serviceman who can use them as 
analysis information.

Notes
• For projectors that support the saving a maintenance log display function. To see if the projector being 

used is supported, refer to the “List of Compatible Device Models” of this application software which is 
posted on the following website. 
https://docs.connect.panasonic.com/projector/download/application

1 From the tree pane on the <Device Monitoring> window, select the device 
or group folder whose log you want to save, right-click it, and select 
[Save Maintenance Log File].
• To save a batch log for all target projectors, select the parent group ([Group] folder),  

right-click, and select [Save Maintenance Log File].
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2 A confirmation message will be displayed. Perform the operation in 
accordance with the information in the message.
When you click [Yes], maintenance log retrieval begins. 
To cancel retrieval of the maintenance log, click [No].

3 Select a folder in which to save the maintenance log and click [OK].
The acquisition of the maintenance log (system log/lamp log/brightness sensor log) of the 
monitored or controlled device commences.
To save to a new folder, click [Make New Folder] to create a new folder.

Depending on the device, the maintenance log is saved in one of the following file formats.
Save method Log Type File name

Save logs 
individually

System log Model Name_Serial No_System_log  
(without extension)

Lamp log Model Name_Serial No_Lamp_log  
(without extension)

Brightness sensor log Model Name_Serial No_ BrightSensor_log  
(without extension)

Save logs all at 
once*1 Batch log Date and Time_Device Name_Model Name_Serial No.  

(extension: .log/.bin)

*1  Batch logs contain all the information contained in system logs, lamp logs, and brightness 
sensor logs.
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4 When the confirmation message is displayed, click [OK].

Notes
• Maintenance logs are saved in binary format.
• Maintenance log information can be checked by service personnel only.
• Maintenance logs are recorded only on devices that support them.
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You can export all information of a registered device to a CSV file. To export device information, 
follow the following steps.

1 Select [Device Management] → [Save Registration Device] from the 
menu.

2 Set the save destination and file name, and click [Save].
The registered device information is saved in an auto-generated file name that indicates the 
year, month, day, hour, minute, and second when the file was saved. You can change the 
file name by entering the desired file name.
• The registered device information will be saved in CSV format. You can see the 

information with Text Editor and Microsoft Excel.

3 When the “saved successfully” message appears, click [OK].
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 ■Example showing saved data
The following descriptions are saved in the registered device information file.

…

Software name
Version
File save date and time
Description Items: Device Name

Group  (If the group folder of the tree pane is , the camera name 
set at the time of network camera registration or CAM-XXX 
(XXX: network camera’s IP address) will be displayed as the 
group name.)

Status (Current status, error/warning information)
Camera
Remote Preview
ECO setup level (displayed numerically)
IP Address
Lamp (Lamp 1 to Lamp 4)/Light device Runtime
Closed Caption
Input
Source Signal
Model Name
Wireless Settings
Intake Air Temperature
Optics Module Temperature
Around Air Temperature
OSD Setting
AC Voltage
Serial Number
Geometry
Board Temperature (FP)
Exhaust Temperature (FP)
Intake Air Temperature (FP)
Panel Temperature (FP)

End-of-file display
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Notes
• The content of description items that will be displayed will only be the items currently displayed in the 

brief information display. To change the items displayed or the display order on the brief information 
display, see page 149.

• “---” is shown for unsupported information or information that cannot be obtained.
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Importing Device Registration Information
Export data created using this software can be imported.
This function is useful for transferring settings information from another computer that this 
software is installed.
• Only users with administrator privileges can perform importing.

1 Select [Device Management] → [Import Settings] from the menu.

2 Select the folder containing the file to be imported and click [OK].
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3 A confirmation dialog will be displayed. Perform the operation in 
accordance with the information in the message.
Click [Yes] to start importing.

4 When the “imported data successfully” message appears, click [OK].
• This software restarts automatically, and the various imported setting information items 

of the computer such as device, group, keyword, brightness control, schedule, and map 
image by the user's selection are updated.

Notes
• Items other than devices, groups, keywords, brightness control, schedules, map image by the user's 

selection, and setting information cannot be imported.
• Export data created using Multi Projector Monitoring & Control Software Ver 1.* can also be imported 

into this software (Multi Monitoring & Control Software).
• Only the data used by the multi monitoring and control functions is imported. 
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Exporting Device Registration Information
Devices, groups, keywords, brightness control, schedules, and setting information that are set 
up in this software can be exported to a file.
This function is useful when transferring setting information to another computer.

1 Select [Device Management] → [Export Settings] from the menu.

2 Select export destination and click [OK].
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3 A confirmation message on whether or not the map image will also be 
exported will be displayed. Operate it according to the content of the 
message.
When you click [Yes], the map image registered in each group is copied to the local disk 
then exported.

4 When the “export successful” message appears, click [OK].
A folder containing the export data is created at the designated export destination and 
named according to the date and time of export.
Example:  Name of data folder if export is performed at 19:56:48 on January 13, 2017: 

20170113195648

Notes
• Items other than devices, groups, keywords, brightness control, schedules, setting information, and 

map image by the user's selection cannot be exported using this function. 
• Do not import the export data created with this software (Multi Monitoring & Control Software) into 

Multi Projector Monitoring & Control Software Ver 2.0, Ver 2.5, Ver 2.6, Ver 2.7, Ver 2.8, Ver 2.9,  
Ver 3.0, Ver 3.1 and Multi Monitoring & Control Software Ver 1.0. The software may stop operating.
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Executing a Control Command
Devices can be controlled on an individual device basis, or on the basis of group, keyword, or 
brightness control.

Attention
• When turning the projector on, take care to ensure that light from the light source cannot enter the 

eyes of people near the projector.

1 From the tree pane of the <Device Monitoring> window, select the icon 
for the device, group, keyword, or brightness control that is the target of 
the control command.

2 Select [Control] → [Control Command] from the menu.

3 Select and click the command to be executed.
• You can execute a control command repeatedly by repeating the command execution 

steps.
• The result of executing the control command will be displayed under [Command 

Execution Result] ( ) and in the “Command execution log pane” (page 22). If an invalid 
control command is executed or a timeout occurs, [NG] is displayed.
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[Power] Command to use: PJLink command*2

Off/on control for the power.

[Shutter(AVMute)] Command to use: PJLink command*2

Open/close control for the shutter or off/on control for AV mute.

[OSD] Command to use: Proprietary command
Controls if the Projector’s OSD information will be displayed or not.

[Device Input]

Command to use: PJLink command
Click an input terminal to select it. (For items with a [  ], hovering 
the mouse pointer shows the available choices.)
• Operations not listed under [Device Input] are carried out by 

selecting combinations of [PJLink Control] and [Status].

[Command Input]*1

Command to use: Proprietary command
Enter the command, and click [Start]. The device is controlled 
according to the contents of the command entered. (You can select 
registered commands from a pull-down menu.)
[Register command]:  You can register commonly used commands.  

(page 94)
[Create command list]:  Creates a list of commands, allowing for 

easy sequence control. (page 95)
• After the software starts, you cannot use [Start] with a command 

until the device information has been updated. First update the 
device information, then click [Start] for a command. (page 92)

• This method cannot be used for switching of the Digital Interface 
Box and DIGITAL LINK Switcher inputs.

[DIGITAL LINK Switcher] Command to use: Proprietary command
Select this to switch the input of the DIGITAL LINK Switcher.

[PJLink Control] / [Status]
Command to use: PJLink command*2

Select the operation to be executed by creating a combination of 
[PJLink Control] and [Status].
• For more information about the combinations, see page 98.

*1  [Command Input] only works on devices that support the “Command Transmission Function”.
*2  Panasonic displays (such as projectors and flat panel displays) supporting PJLink can perform the 

operations that use the PJLink command.

4 Click [Close] ( ) to close the <Control Command> window.
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 ■Registering and transmitting commands (maximum of 20)
1 Click [Register command] for [Command Input].

2 Enter the command you want to register.
• If you read in command information (CSV format) (page 97) using [Read File] ( ), you 

can then select the read-in commands from a pull-down menu.

[Command]:Enter a command directly, or select a read-in command from a pull-down 
menu.

[Memo]: If necessary, enter additional information here (maximum: 128 half-width or 
64 full-width characters).

[Send]: Transmit the command you entered to the device.

3 Click [Close] ( ) to close the window.
The command you entered is registered.
• Registered commands can be selected from a pull-down menu on the [Control Command] 

window when entering commands.

Notes
• After the software starts, you cannot transmit commands until the device information has been 

updated. First update the device information, then transmit a command.
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 ■Creating and transmitting command list (maximum of 100)
1 Click [Create command list] for [Command Input].

2 Add an input line with [Add line] ( ), and enter a command.
• When you enter the execution file name of the application installed in your computer, you 

can start the application. (When startup has failed, nothing will be displayed.)
After entering @ (at sign), enter the full path of the execution file, and enclose the path 
in “ ” (double quotation marks).
When parameters are necessary, enter a single-byte space after , and add the 
parameters enclosed in “ ” (double quotation marks).
• When parameters are included in the file, specify the full path.

Example: @”C:\Program Files\TEST\test.exe” “/P” “/B”

• If you read in a command list (CSV format) (page 97) using [Read file] ( ), you can then 
select the read-in commands from a pull-down menu.

[Add Interval]: Add a line with the Interval (wait time) command. You can set the 
execution interval before and after the Interval command from 
0 to 999 seconds.

[Delete selected line]: Delete the selected command.
[All delete]: Delete all commands from the list.
[  ] / [  ]: Change the order of the selected command in the list.
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3 Click [Start] ( ). 
Commands are transmitted to the target device in order, starting from the top of the command 
list.
• If you quit without clicking [Start], the list you created is deleted. To retain the command list 

you created, click [Save file] ( ) to save the list in CSV format to a folder of your choice.

4 Click [Close] ( ) to close the window.

Notes
• After the software starts, you cannot transmit commands until the device information has been 

updated. First update the device information, then transmit commands.
• You can perform command input and list reading from the <Create Schedule> window (page 108) as 

well. Commands created at the <Create Schedule> window are added to the schedule and executed 
on the set time and date.
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 ■Creating command information
Use [Register command] to create command information conforming to the following conditions 
that can be read into the software.
• File format: CSV
• Character code: EUC / UTF-8 / Shift_JIS
• The maximum number of commands that can be read in is 20.
• The command information consists of one command per line, with each line ending with a 

comma (,) and a line break.
• To enter a comment line, omit the comma (,) at the end of the line.

Example: Power ON
Power OFF

PON, Power ON [line break] 
POF, [line break]

 ■Creating a command list
Use [Create command list] to create a command list conforming to the following conditions that 
can be read into the software.
• File format: CSV
• The maximum number of commands that can be read in is 100.
• The command information consists of one command per line, with each line ending with a 

comma (,) and a line break.
• To insert an interval between commands, add the Interval command (“Interval,XX” (XX: enter 

a wait time of 0 to 999 seconds)) between the commands between which you wish to insert 
an interval.

Example: Turn on power, then turn off power after 20 seconds.

PON, [line break]
Interval, 20 [line break]
POF, [line break]
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 ■Combinations of [PJLink Control] and [Status]
[PJLink Control] [Status] Combination result

[Power]
[OFF] Power OFF
[ON] Power ON

[Input RGB]

[1] Switching to the RGB input that corresponds to parameter 
“11” of the PJLink input switching command INPT.

[2] Switching to the RGB input that corresponds to parameter 
“12” of the PJLink input switching command INPT.

[3] Switching to the RGB input that corresponds to parameter 
“13” of the PJLink input switching command INPT.

[4] Switching to the RGB input that corresponds to parameter 
“14” of the PJLink input switching command INPT.

[5] Switching to the RGB input that corresponds to parameter 
“15” of the PJLink input switching command INPT.

[6] Switching to the RGB input that corresponds to parameter 
“16” of the PJLink input switching command INPT.

[7] Switching to the RGB input that corresponds to parameter 
“17” of the PJLink input switching command INPT.

[8] Switching to the RGB input that corresponds to parameter 
“18” of the PJLink input switching command INPT.

[9] Switching to the RGB input that corresponds to parameter 
“19” of the PJLink input switching command INPT.

[A] to [Z] Switching to the RGB input that corresponds to parameter 
“1A” to “1Z” of the PJLink 2 input switching command INPT.

[Input VIDEO]

[1] Switching to the VIDEO input that corresponds to parameter 
“21” of the PJLink input switching command INPT.

[2] Switching to the VIDEO input that corresponds to parameter 
“22” of the PJLink input switching command INPT.

[3] Switching to the VIDEO input that corresponds to parameter 
“23” of the PJLink input switching command INPT.

[4] Switching to the VIDEO input that corresponds to parameter 
“24” of the PJLink input switching command INPT.

[5] Switching to the VIDEO input that corresponds to parameter 
“25” of the PJLink input switching command INPT.

[6] Switching to the VIDEO input that corresponds to parameter 
“26” of the PJLink input switching command INPT.

[7] Switching to the VIDEO input that corresponds to parameter 
“27” of the PJLink input switching command INPT.

[8] Switching to the VIDEO input that corresponds to parameter 
“28” of the PJLink input switching command INPT.

[9] Switching to the VIDEO input that corresponds to parameter 
“29” of the PJLink input switching command INPT.

[A] to [Z] Switching to the VIDEO input that corresponds to parameter 
“2A” to “2Z” of the PJLink 2 input switching command INPT.
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[PJLink Control] [Status] Combination result

[Input DIGITAL]

[1] Switching to the DIGITAL input that corresponds to 
parameter “31” of the PJLink input switching command INPT.

[2] Switching to the DIGITAL input that corresponds to 
parameter “32” of the PJLink input switching command INPT.

[3] Switching to the DIGITAL input that corresponds to 
parameter “33” of the PJLink input switching command INPT.

[4] Switching to the DIGITAL input that corresponds to 
parameter “34” of the PJLink input switching command INPT.

[5] Switching to the DIGITAL input that corresponds to 
parameter “35” of the PJLink input switching command INPT.

[6] Switching to the DIGITAL input that corresponds to 
parameter “36” of the PJLink input switching command INPT.

[7] Switching to the DIGITAL input that corresponds to 
parameter “37” of the PJLink input switching command INPT.

[8] Switching to the DIGITAL input that corresponds to 
parameter “38” of the PJLink input switching command INPT.

[9] Switching to the DIGITAL input that corresponds to 
parameter “39” of the PJLink input switching command INPT.

[A] to [Z]
Switching to the DIGITAL input that corresponds to 
parameter “3A” to “3Z” of the PJLink 2 input  switching 
command INPT.

[Input STORAGE]

[1] Switching to the STORAGE input that corresponds to 
parameter “41” of the PJLink input switching command INPT.

[2] Switching to the STORAGE input that corresponds to 
parameter “42” of the PJLink input switching command INPT.

[3] Switching to the STORAGE input that corresponds to 
parameter “43” of the PJLink input switching command INPT.

[4] Switching to the STORAGE input that corresponds to 
parameter “44” of the PJLink input switching command INPT.

[5] Switching to the STORAGE input that corresponds to 
parameter “45” of the PJLink input switching command INPT.

[6] Switching to the STORAGE input that corresponds to 
parameter “46” of the PJLink input switching command INPT.

[7] Switching to the STORAGE input that corresponds to 
parameter “47” of the PJLink input switching command INPT.

[8] Switching to the STORAGE input that corresponds to 
parameter “48” of the PJLink input switching command INPT.

[9] Switching to the STORAGE input that corresponds to 
parameter “49” of the PJLink input switching command INPT.

[A] to [Z]
Switching to the STORAGE input that corresponds to 
parameter “4A” to “4Z” of the PJLink 2 input switching 
command INPT.
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[PJLink Control] [Status] Combination result

[Input NETWORK]

[1] Switching to the NETWORK input that corresponds to 
parameter “51” of the PJLink input switching command INPT.

[2] Switching to the NETWORK input that corresponds to 
parameter “52” of the PJLink input switching command INPT.

[3] Switching to the NETWORK input that corresponds to 
parameter “53” of the PJLink input switching command INPT.

[4] Switching to the NETWORK input that corresponds to 
parameter “54” of the PJLink input switching command INPT.

[5] Switching to the NETWORK input that corresponds to 
parameter “55” of the PJLink input switching command INPT.

[6] Switching to the NETWORK input that corresponds to 
parameter “56” of the PJLink input switching command INPT.

[7] Switching to the NETWORK input that corresponds to 
parameter “57” of the PJLink input switching command INPT.

[8] Switching to the NETWORK input that corresponds to 
parameter “58” of the PJLink input switching command INPT.

[9] Switching to the NETWORK input that corresponds to 
parameter “59” of the PJLink input switching command INPT.

[A] to [Z]
Switching to the NETWORK input that corresponds to 
parameter “5A” to “5Z” of the PJLink 2 input switching 
command INPT.

[AVMute VIDEO]*
[ON] AV mute (video only) ON/shutter closed
[OFF] AV mute (video only) OFF/shutter open

[AVMute AUDIO]*
[ON] AV mute (audio only) ON
[OFF] AV mute (audio only) OFF

[AVMute VIDEO + AUDIO]
[ON] AV mute (video and audio) ON/shutter closed
[OFF] AV mute (video and audio) OFF/shutter open

*  Panasonic devices are not currently supported.

Notes
• For details on the compatible functions of each device, refer to the “List of Compatible Device Models” 

of this application software which is posted on the following website. 
https://docs.connect.panasonic.com/projector/download/application 
https://docs.connect.panasonic.com/prodisplays/download/software

• For details on individual functions and device-side operations, refer to the instruction manual of the 
device or peripheral device.

• If an input switching command that does not exist for a particular model has been set, “Unsupported” 
will be displayed in [Command Execution Result] and in the command execution log pane of the 
<Device Monitoring> window.

• TH-D3500 does not support the [Device Input].
• Switching of the Digital Interface Box inputs can be executed only when a Digital Interface Box is 

connected to a device that supports DIGITAL LINK.
• Switching of the DIGITAL LINK Switcher inputs can be executed only when a DIGITAL LINK Switcher 

is connected to a device that supports DIGITAL LINK.
• When the Digital Interface Box or DIGITAL LINK Switcher switch command is sent to a device that 

does not support DIGITAL LINK, “Unsupported” is displayed at [Command Execution Result] and in 
the command execution log display area of the <Device Monitoring> window.
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Saving or Deleting the Log
You can save and delete the log information displayed in the log pane.

Notes
• Up to 10,000 log entries can be saved. Once 10,000 log entries are reached, old log entries are 

deleted to make room for new ones.

1 Right-click on the command execution log pane of the <Device 
Monitoring> window to display the <Menu> window.

<Menu> window

2 Select [Save Log Information] or [Clear Log Information].
[Save Log Information]: The log information is saved in CSV format in the specified folder.
[Clear Log Information]: The log information displayed in the log pane is deleted.
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1 From the tree pane of the <Device Monitoring> window, select the icon 

for the device, group, or device-registered keyword or brightness control 
group whose schedule is to be set, right-click it, and select [Schedule].
• Alternatively, you can use the following method.

 - Select [Device Management] → [Schedule] from the menu.

2 On the schedule setting screen, select from the following operations.
[Date and time specification]: Select the date and time specification to view what has 

already been scheduled.
[Schedule addition]: Create a new schedule. (Go to step 3 in page 103)
[Edit]: Edit the selected schedule. (Go to step 3 in page 103)
[Delete]: Remove the selected schedule. (Go to step 4 in page 103)



103

Controlling Devices

Scheduling Function

3 Select the date and time, the control function to be executed, and the 
order to perform the operation, and then click [OK] ( ).
• The following is the screen when [Schedule addition] is selected. If [Edit] is selected, the 

settings will be the same.

[Date Settings] Select [Specified Date], [Everyday], or [Weekly] (by day of the week) and then set 
[Time]. (You cannot set a time that is before the creation date and time.)

[Setting and 
Control]

Select one of the following items and set the execution details.
• [Operation Settings] (page 105)
• [Command Settings] (page 106)
• [Command list Settings] (page 108)

• [Distribute captions] (page 110)
• [Stop caption distribution] (page 110)
• [Brightness Control] (page 118)
• [Delivering contents list] (page 121)

4 Return to the screen in step 2 and click [Close].
• When the schedule settings are done,  will appear in the tree pane of the <Device 

Monitoring> window. If the schedule is deleted, the  disappears.

Notes
• When using the schedule settings to power on a projector, the schedule should only be set up for a 

projector installed in an environment where light from the projector cannot enter the eyes of nearby 
people when the projector starts.

• Up to 100 schedules can be set.
• To see if the equipment being used supports a particular control function, refer to the “List of 

Compatible Device Models” of this application software which is posted on the following website. 
https://docs.connect.panasonic.com/projector/download/application 
https://docs.connect.panasonic.com/prodisplays/download/software
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Checking schedules that have been set up
You can view a list of the schedules that have been set up.

1 Select [Options] → [All Schedule List] from the menu.

• If there are overlapping schedules for a specified device, its lines will be indicated in red. If 
there are overlapping schedules (with the same start time specified for multiple commands 
for the same device), proper operation of the device cannot be guaranteed. To change an 
overlapping schedule, select [Edit] or [Delete] in step 2 of “Scheduling Function”.  
(page 102)

• The <Schedule List> window displays a list of schedules that have been set up for each 
device. Schedules for up to 100 devices can be displayed at any one time. If there are 
schedules for more than 100 devices, buttons for moving between pages, the page 
number, and the total number of pages will appear at the bottom of the window.
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Sent ([Operation Settings])

 ■Configuration by specifying a date and time in [Schedule]
1 Select the icon for the desired device, group, or keyword from the tree pane 

of the <Device Monitoring> window, right-click it, and select [Schedule]. 
(page 102)

2 On the schedule setting screen, click [Schedule addition] or [Edit].

3 Specify the date and time, and select [Operation Settings].
• Select [Specified Date], [Everyday], or [Weekly] (by day of the week) and then set [Time].

4 Select the check boxes of the items to be controlled, and then configure their 
settings.

[Power] Off/on control for the power.

[Shutter (AVMute)]
Open/close control for the shutter or off/on control for AV mute.
• To control AUDIO and VIDEO individually, select either [VIDEO], [AUDIO], 

or [VIDEO + AUDIO] from the left-side pull-down menu and select [ON] or 
[OFF] from the right-side pull-down menu.

[Input]

[Device Input]:  Select this to switch the input to the device. (For items with [  ], 
hovering the mouse pointer shows the available choices.)

[DIGITAL LINK Switcher]:  Select this to switch the input of the Digital 
Interface Box or DIGITAL LINK Switcher.

• Click an input terminal to select it.
• If you want to execute individual control, select the operation to be 

executed by creating a combination of [PJLink Control] and [Status].
[PJLink Control] / [Status]:  Select the operation to be executed by creating 

a combination of [PJLink Control] and [Status].
• For more information about the combinations, see page 98.

5 Use the [Order] selectors to specify the order of the operations and then click 
[OK]. 
The content set will be added to the schedule.
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([Command Settings])

The commands that can be set and the periods for disabling command reception vary 
depending on the device you are using. For details, refer to the instruction manual for your 
device.

 ■Configuration by specifying a date and time in [Schedule]
1 Select the icon for the desired device, group, or keyword from the tree pane 

of the <Device Monitoring> window, right-click it, and select [Schedule]. 
(page 102)

2 On the schedule setting screen, click [Schedule addition] or [Edit].

3 Specify the date and time, and select [Command Settings].
• Select [Specified Date], [Everyday], or [Weekly] (by day of the week) and then set [Time].

4 Enter the command to send in [Transmitting command].
You can only use single byte capital/small letters (alphabet), numbers, and symbols. You can 
enter up to 256 characters.
• When you enter the execution file name of the application installed in your computer, you 

can start the application. (When the start has failed, nothing will be displayed.)
In [Transmitting command1], after entering @ (at sign), enter the full path of the 
execution file, and enclose the path in “ ” (double quotation marks).
When parameters are necessary, after entering @ (at sign), enter parameters in 
[Transmitting command2] and [Transmitting command3], and enclose them in “ ” 
(double quotation marks), respectively.

Example:  [Transmitting command1]: @”C:\Program Files\***\test.exe” (execution file) 
[Transmitting command2]: @”/P” (parameter) 
[Transmitting command3]:  @“C:\Document\***\text.txt” (When parameters are 

included in the file)

5 Put a check on the commands to send. (All commands are checked by default.)
Checked commands will be sent in order from the top.
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6 Set the command sending interval in [Transmission interval].
Select [5], [10], [15], or [30] seconds as the sending interval for multiple commands (up to 
3 commands can be sent). (Default setting value: 5 seconds)
• The number of seconds that you select in [Transmission interval] will be invalid, if a call 

command is entered at Step 4.

7 Click [OK].
The content set will be added to the schedule.
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You can register created command lists (page 97) to the schedule.
 ■Configuration by specifying a date and time in [Schedule]

1 Select the icon for the desired device, group, or keyword from the tree pane 
of the <Device Monitoring> window, right-click it, and select [Schedule]. 
(page 102)

2 On the schedule setting screen, click [Schedule addition] or [Edit].

3 Specify the date and time, and select [Command list Settings].
• Select [Specified Date], [Everyday], or [Weekly] (by day of the week) and then set [Time].

4 Click [Read file] ( ).
• Read the command list (CSV format) to be registered to the schedule. (Maximum of 100 

lists)

5 Select the command list you want to read, and click [Open].
When the reading success message is displayed, click [OK].
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6 Select the command you want to register from the pull-down menu of the read 
command list.
• You can also delete the read command or adjust its interval ( ).

[Add line]: Add a command input line.
[Add Interval]: Add a line with the Interval (wait time) command. You can set the 

execution interval before and after the Interval command from 0 to 999 
seconds.

[Delete 
selected]:

Delete the selected command.

[All delete]: Delete all commands from the list.
[  ] / [  ]: Change the order of the selected command in the list.

7 Click [OK].
• The set command list will be added to the schedule.
• If you click [Cancel] without clicking [OK], the set command list will be deleted. To retain 

the command list you set, click [Save file] ( ) to save the list in a CSV format to a folder of 
your choice.
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[Distribute captions]: You can distribute a caption of your choice onto the specified 
position on the display to a flat panel display that is equipped with 
a caption playback function. (page 114)

[Stop caption distribution]: Delete a distributed caption. (page 116)

Notes
• To see if the device you are using supports the caption playback function, refer to the “List of 

Compatible Device Models” of this application software which is posted on the following website. 
https://docs.connect.panasonic.com/prodisplays/download/software

• In some models, when the setting of [No signal auto off] is enabled in the device menu, the power 
supply to the device is turned off if the time set in [No signal auto off] has elapsed after [Distribute 
captions] or [Stop caption distribution] is performed even if the delivered image data is still being 
displayed. To use this function, disable the setting of [No signal auto off] in the device menu.

• When scheduling image delivery with a specified character font and exporting the setting of that device 
to another computer, if the font does not exist in the destination computer, the characters are displayed 
in the default font of the OS. The default font varies according to OS and language.

• Display a preview of the setting status of the caption distribution using the specified font. Preview 
display is a guide for operation check so it may differ from the caption display of the actual device.

Create and edit a caption list.
1 Select the icon for the desired device, group, or keyword from the tree 

pane of the <Device Monitoring> window, right-click it, and select  
[Edit and distribute captions].
• Alternatively, you can use the following method.

 - Display the schedule setting screen with Step 1 and 2 from page 102, and place a 
check on [Edit] or [Schedule Addition] → [Setting and Control] → [Distribute captions].
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2 Click [Edit caption list].

3 Select a caption to create or edit from [Caption list].
[Caption list]: To create new content, select a content that has not been created yet 

(or is no longer needed). To edit content, choose a list name you want 
to edit.

[Change]: When you click the selected List name after directly rewriting the 
name, the changed list name will be confirmed. Up to 32 alphanumeric 
characters can be entered.

[Clear]: The List name will return to its default state and the set content of the 
[Caption information] will be discarded.
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4 Input the caption you will distribute into [Input for the characters to be 
displayed] ( ).
You can input a maximum of 512 characters.

5 Set the caption display position with [Background] ( ).
[Position]: Select the position to display.
[Transmittance]: Set the transmittance of the background color.
[Color]: Select the text color from the color palette.

6 Select whether to scroll or not with [View] of [Scroll] ( ).
• To allow scrolling, click [On] and set the following items.
[Position]: Select the position to align the character string.
[Speed]: Select the caption scrolling speed from 3 levels.
[Repeat count]: Set how many times the caption distribution will repeat.

If you select [Infinite], it will continue repeating during distribution.
[Repeat wait time]: Set the distribution interval between captions.

7 Set a character style with [Character] ( ).
[Font]: Set the text font.

• The fonts saved in the computer being used can only be selected.
• Since preview display is only an image, it may differ from the actual font 

caption displayed in the device. 
[Size]: Set the text size. 
[Color]: Select the text color from the color palette.
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8 Click [Setting] ( ).
The setting will be completed, and the list created will be displayed in [Distribute captions].
• Click [Setting] for each list. If you change the [List name] without pressing [Setting], the 

content set in [Caption information] will be discarded.
• If you click [Close] ( ), the set content will be discarded and the setting screen will close.
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Distribute the caption list

Notes
• The caption list will not be distributed to devices not connected to the network during distribution.
• When caption list distribution is performed, the content set at [Device list setting] will automatically be 

saved. 
The next time the caption list distribution window is started, the automatically saved set content will be 
displayed.

• If the power of the device unit is turned off or the connection with the unit is disconnected during 
delivery, the delivery will fail. Check the status of the connection with the unit and then execute 
delivery again.

 ■Configuration by specifying a date and time in [Schedule]
1 Select the icon for the desired projector, group, or keyword from the tree 

pane of the <Device Monitoring> window, right-click it, and select [Schedule]. 
(page 102)

2 On the schedule setting screen, click [Schedule addition] or [Edit].

3 Specify the date and time, and select [Distribute captions].
• Select [Specified Date], [Everyday], or [Weekly] (by day of the week) and then set [Time].

4 Select a list to distribute from [Distribute captions] ( ).
• If a group or keyword icon is selected at Step 1, you can select a different list for each 

device.
• If nothing is displayed in the list, it is necessary to create a caption list. (page 110)

5 Click [OK].
The caption list distribution will be completed.
• After the setting is complete, leave the software running. If the software ends or the 

computer goes into sleep mode, caption list distribution will not be performed on the date 
and time set. 
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 ■Configuration directly from the menu
1 From the tree pane of the <Device Monitoring> window, select the icon for 

a device, group, or keyword, right-click it, and select [Edit and distribute 
captions].

2 Select a list to distribute from [Distribute captions] ( ).
• If a group or keyword icon is selected at Step 1, you can select a different list for each 

device.
• If nothing is displayed in the list, it is necessary to create a caption list. (page 110)

3 Click [Distribution].
The set content of the list will be sent to the device to be distributed via LAN and caption list 
distribution will be performed.
• To save the set content, click [Apply].
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Deleting distributed captions

 ■Deletion by specifying a date and time in [Schedule]
1 Select the icon for the desired projector, group, or keyword from the tree 

pane of the <Device Monitoring> window, right-click it, and select [Schedule]. 
(page 102)

2 On the schedule setting screen, click [Schedule addition] or [Edit].

3 Specify a date and time then select [Stop caption distribution].
Select [Specified Date], [Everyday], or [Weekly] (by day of the week) and then set [Time].

4 Click [OK].
Distribution settings will be deleted.
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 ■Directly deleting from the menu
Deleting captions being distributed, directly from the menu.
1 From the tree pane of the <Device Monitoring> window, select the icon for the 

delivery target device, group, or keyword, right-click it, and select [Caption 
deletion].
Distribution settings will be deleted.
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([Brightness Control])

When multiple projectors equipped with the brightness control function is used to project an 
integrated image, the function automatically controls the projectors so that the brightness 
between the projected images from each of the projectors are held uniform.
• Brightness control is a function to help you maintain the brightness of multiple projectors at a 

uniform level. It does not guarantee that the brightness of all projectors will completely match.

Notes
• To see if a device being used supports [Brightness Control], refer to the “List of Compatible Device 

Models” of this application software which is posted on the following website. 
https://docs.connect.panasonic.com/projector/download/application

An illustration of brightness control
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Change in brightness Brightness is corrected 
to be uniform

Projector settings
Configure the following settings from the on-screen menu of each projector.

1 Adjust the gain value so that the brightness of the projectors match.

2 Go to [MAIN MENU] → [PROJECTOR SETUP] → [Brightness Control] → 
[Brightness Control Setting], and set the [Mode] (or [Fixed Mode]) to [PC].

Notes
• For how to adjust the brightness of the projector, please refer to the operating manual for the projector 

being used.
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 ■Execution by specifying a date and time in [Schedule]
1 From the tree pane of the <Device Monitoring> window, select the icon for 

the brightness control whose schedule is to be set, right-click it, and select 
[Schedule]. (page 102)

2 On the schedule setting screen, click [Schedule addition] or [Edit].

3 Specify the date and time, and select [Brightness Control].
• Select [Specified Date], [Everyday], or [Weekly] (by day of the week) and then set [Time].

4 Click [OK] to end the setting.

 ■Executing directly from the menu
You can set [Brightness Control] directly from the menu without setting the execution date and 
time in the schedule.
1 From the tree pane of the <Device Monitoring> window, select a brightness 

control icon, right-click it, and select [Manual Brightness Control].
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Checking the progress status of brightness control
When the brightness control is executed, the status bar at the bottom of the screen changes 
from [Ready] to [Brightness Control is being executed.] and a progress bar appears on the 
right side. When the display returns to [Ready], it means that brightness control execution has 
completed.
• If brightness control is not successful, a warning icon is displayed next to the brightness 

control icon on the tree pane of the <Device Monitoring> window.

Notes
• Brightness control may not be successful when the projector is in the following states. Check the 

projector status before attempting brightness control again.
 - A projector is undergoing lamp relay.
 - A projector is in standby mode (it is turned off)
 - The computer cannot connect to a projector (e.g. poor LAN cable connection)
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The content list delivery function delivers content (still images and movies) that can be played 
with a USB media player or Scenario playback function, together with the corresponding play 
list for the content. The content must be delivered to a flat panel display equipped with the 
USB media player function or a projector equipped with the “Scenario” playback function in its 
“Memory Viewer” function.

Notes
• To use the content list delivery function, you need to insert a formatted USB memory device into the 

device unit. For details on the specifications of USB memory devices that can be used, refer to the 
instruction manual for your device.

• When you use the content list delivery function, the delivered content list (content and play list) is 
written to the USB memory device inserted in the device unit. If there is already content or a play 
list with the same file name in the delivery destination USB memory device, it will be overwritten 
regardless of the write-protect setting.

• Even if content is directly saved to the USB memory device after delivering the content and play list 
using the content list delivery function, that content will not be played as it is not registered in the play 
list.

• To see if the device being used supports [Delivering contents list], refer to the “List of Compatible 
Device Models” of this application software which is posted on the following website. 
https://docs.connect.panasonic.com/projector/download/application 
https://docs.connect.panasonic.com/prodisplays/download/software

• For details on portrait settings, refer to the instruction manual for your flat-panel display.
• For details on the USB media player function, refer to the instruction manual for your flat panel display.
• For details on the Memory Viewer Scenario playback function, refer to the instruction manual for your 

projector.



122

Controlling Devices

Creating a List to Distribute Images ([Delivering contents list])

 ■Types of content files that can be delivered
Still images ○: Support  ×: Not support

Extension Format Restrictions*1 Projector Flat panel 
display

jpg
jpeg

JPEG
Maximum number of pixels: 4,096 × 4,096
YUV format: Only YUV444 and YUV422 supported
Color mode: Only RGB supported

○ ○

jpe × ○

bmp Bitmap
Maximum number of pixels: 2,000 × 2,000
Color bit depth: 1, 4, 8, 16, 24, 32 bits supported

○ ×

Movie

Extension
Codec Restrictions*2

Projector Flat panel 
displayVideo Audio Video Audio

mov H.264 AAC, HE-AAC
Linear PCM

Resolution:
Maximum 
1,920(W)×1,080(H)
(For 4K compatible 
flat panel displays, the 
maximum resolution is 
3,840(W) × 2,160(H))
Frame rate:
Maximum 30 fps
(For 4K compatible 
flat panel displays, 
the frame rate is up 
to 60 fps*3)
Bit rate:
Maximum 40 Mbps
(For 4K compatible 
flat panel displays, 
the bit rate is up to 
80 Mbps*3)

Sample rate:
Maximum 48 kHz  
(Maximum 16 kHz 
for Linear PCM)
Channel:
Maximum 2 ch
Bit rate:
Maximum 384 kbps

○ ○

avi H.264,  
MPEG4 part2

MPEG1 Layer2
Linear PCM ○ ○

mp4 H.264,  
MPEG4 part2 AAC ○ ○

ts
mts

H.264,  
MPEG4 part2

MP3
MPEG1 Layer2

HE-AAC
× ○

wmv
WMV9

VC-1 Simple & 
Main

WMA Standard
WMA9/10 Pro ○ ○

asf

H.264,  
MPEG4 part2

VC-1 Advanced
AP@L3

VC-1 Simple & 
Main

WMA Standard
WMA9/10 Pro × ○

3gp H.264,  
MPEG4 part2 AACHE-AAC × ○

mkv H.264,  
MPEG4 part2

MPEG1 Layer2
HE-AAC × ○

flv
f4v H.264

MP3
AAC

Linear PCM
× ○

mpg
mpeg MPEG2 MPEG1Layer2 ○ ×

*1   Progressive JPG is not supported.
*2   Following movie files are not supported.

• Multi-angle video
• Files with the profile of Advanced Simple Profile @ Level 0 or Advanced Simple Profile @ Level 1

*3    Depending on the type of codec, playback may not be possible even if it is within the numerical values 
of restrictions.
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Creating and editing content lists
1 Select the icon for the desired device, group, or keyword from the 

tree pane of the <Device Monitoring> window, right-click it, and select 
[Content list editing and delivery].
• Alternatively, you can use the following method.

 - Display the schedule setting screen with Step 1 and 2 from page 102, and place a 
check on [Edit] or [Schedule Addition] → [Setting and Control] → [Delivering contents 
list].

2 Click [Content list editing].
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3 Select the content list to be created or edited from the [List name]  
pull-down menu.
[List name]: To create new content, select a content that has not been created yet. To 

edit content, choose a list name you want to edit.
[Change]: When you click the selected [List name] after directly rewriting the name, 

the changed list name will be confirmed. Up to 32 alphanumeric characters 
can be entered.

[Clear]: The [List name] will return to its default state and the set content of the 
[Play List] will be discarded. 

4 Click [Add] and select the content to be played back.
The file selection window appears. Select the content file to register to the play list and then 
click [Open]. (Multiple files can be selected by clicking them while pressing the Shift key or 
Ctrl key.)
• If the selected file is a still image, the image is displayed in . If it is a movie, an icon 

representing the movie is displayed in .
• The selected file name will appear in [Play List].
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5 Click [  ] / [  ] to specify the content playback sequence.
• The files displayed in [Play List] are played in order from top to bottom on the USB media 

player or Memory Viewer.
• To delete a file from [Play List], select the [Select] check box for the file you wish to delete 

and then click [Delete].

6 Enter the playback duration for each content file under  
[Playback time (sec)] in the [Play list].
A playback time within the range of 3 to 86,400 seconds (equivalent to 24 hours) can be set.
• In the case of a still image, the default value is 10 seconds. In the case of a movie, the 

playback time of the selected movie file is the initial value. The playback time may not be 
acquired for some of the selected movie files. If the playback time cannot be acquired, the 
default playback time is 10 seconds.
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7 (Projector)
Proceed to step 8.

(Flat-panel display)
Place a check on the content you want to display in portrait.
When you place a check, the message [When the single playback mode is selected, the 
portrait setting is disabled.] is displayed.
• When you place a check, it is associated with the “Portrait settings” set with the device.

8 Perform saving and setting.

([Save])
You can save it in a desired location, such as your computer or external memory. You can 
also use saved content lists in a USB memory by directly inserting the USB memory into the 
device.

Click [Save] ( ).
Select a playback mode and click [Save].
[Single playback]: Select when performing playback on a single device.

• When [Single playback] is selected, portrait display will not be performed 
even if a check is placed at step 7.

[Multi playback]:  Select when performing synchronized playback on multiple devices. 
([Parent] : Place a check when the set device will be considered as the parent.)
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Specify a save destination and click [OK].
Returns to the screen of step  (page 126).

([Setting])
The created [Play List] will be saved in the software.

Click [Setting] ( ).
The setting will be completed, and the list created will be displayed in [Delivery content list].
• When you change the [List name] or close the screen without clicking [Setting], the content set 

at [Play List] is discarded.

• When you click [Save] ( ), you can perform the same operation with step 8 ([Save]) with 
each list. (page 126)

Notes
• For contents checked in [Portrait], a “P” is added to the end of the corresponding line of the exported 

“File list (filelist.dat)” when saving the list.
• If [Multi playback] is selected when saving, make sure to check [Parent] for one device and set it as 

the parent. (The device set as the [Parent] should only be one device within the same group number) 
When the device set as the parent begins to play, the other devices (sub device) within the same 
group number will also begin to play.

• If [Multi playback] is selected when saving, the group number used to classify the network is fixed to 
“G01”. To change the group number, it is necessary to directly rewrite the “File list (filelist.dat)” that is 
exported when the content list is saved.

• For details on the saved file, see  of step 5 in “Configuration directly from the menu”. (page 133)
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 ■Using Files Created with PowerPoint for Delivery
A file created in PowerPoint can be converted to still images or a movie and then delivered as 
content.
• When a file created in PowerPoint is converted to still images or a movie, conversion may 

take a while depending on the animation effects and number of slides.

Preparation:
• Make sure Microsoft PowerPoint is installed on your computer.
• Supported versions: Microsoft PowerPoint 2010/2013
1 Click [Content list editing].

Display the screen with the methods below. (The same with Step 1 of page 123)
 - From the <Device Monitoring> window, select the icon for a device, group, or keyword then 
right-click it and select [Content list editing and delivery].

 - Display the schedule setting screen with Step 1 and 2 from page 102, and place a check 
on [Edit] or [Schedule Addition] → [Setting and Control] → [Delivering contents list].

2 Click [Use a PowerPoint].



129

Controlling Devices

Creating a List to Distribute Images ([Delivering contents list])

3 Click [Select], and select the PowerPoint file.
The first image of the selected PowerPoint slide is displayed in .
• If you select [New/Edit] ( ) after selecting a file, the selected file will open in PowerPoint.  

If you select [New/Edit] ( ) before selecting a file, you can create a new file.

4 Click ( ) [Convert(.JPG)] or [Convert(.WMV)].
The selected file is converted to a still image (JPG) or movie (WMV), and a completion 
message is displayed.
• When a file is converted to still images, settings such as animation effects are discarded.
• Conversion to a still image can be done at the resolution selected in [Size]. When [Default 

(PPT)] is selected, the image will be converted according to the configuration of your 
PowerPoint presentation tool.

• When a file is converted to a movie, conversion may take a while depending on the 
animation effects, number of slides, and other settings.

5 Click [Close] ( ) and return to the screen of step 2.
The power point file selected will be displayed in [Play List].

6 Set the playback order, playback time, and portrait, then click [Setting].
For more details, see steps 5 to 8 of "Creating and editing content lists". (page 125)
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Delivering a content list

 ■Execution by specifying a date and time in [Schedule]
1 From the tree pane of the <Device Monitoring> window, select the icon for a 

device, group, or keyword, right-click it, and select [Schedule]. (page 102)
2 On the schedule setting screen, click [Schedule addition] or [Edit].

3 Specify the date and time, and select [Delivering contents list].
• Select [Specified Date], [Everyday], or [Weekly] (by day of the week) and then set [Time].

4 Select the list to be delivered from the [Delivery content list] ( ).
• When a group or keyword icon is selected in step 1, different lists can be selected for each 

device.
• If nothing appears in the pull-down lists, it means content lists need to be created. 

(page 123)
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5 Select the [Playback mode setting] ( ).
[Single-Playback]: For playback on a single projector or a single flat panel display
[Multi-Playback]: For starting playback simultaneously on multiple flat panel displays 

• If the delivery target device is a projector, you cannot select [Multi-
Playback].

6 If you selected [Multi-Playback] in step 5, set the [Parent] and [Group No].
• The [Group No] setting is identical to the group ID used to classify networks when using 

USB media players in Multi Media Player mode.
• You must also specify one flat panel display within the group as the Parent. When USB 

media player playback on the flat panel display specified as the Parent (primary display) 
starts, USB media player playback on the other flat panel displays in the same group (sub 
displays) also starts.

• If another flat panel display on the same network and with the same group ID is already 
specified as the primary display, [Parent] cannot be specified.

• To view the content that will be delivered, click [Confirmation]. The input signal, display 
mode (aspect ratio), and other information will be displayed on the corresponding flat panel 
display.

7 Click [OK].
Clicking [OK] will complete the content list delivery setting. 
• After the setting is complete, leave the software running. If the software is exited or the 

computer enters the sleep state, content list delivery will not be performed on the set date 
and time.

Notes
• It may take a while for delivery to complete after it is started depending on the sizes of the content 

files.
• The content list is not delivered to any device that is not connected to the network at the time of 

delivery.
• The functions set in “POWER MANAGEMENT SETTINGS” of the flat panel display are disabled 

during content list delivery.
• If a flat panel display that is a delivery target is playing existing content with the USB media player, 

playback stops simultaneously with the start of content list delivery and then resumes with the new 
content after delivery completes.

• If the delivery target projector is playing back an existing scenario in Memory Viewer, playback stops 
simultaneously with the start of content list delivery and then resumes with the new scenario after 
delivery completes.

• When content list delivery is executed, the settings specified in [Device list setting] are automatically 
saved. The automatically saved settings will appear in the <Content list delivery> window the next time 
you open it.

• If the power of the device unit is turned off or the connection with the unit is disconnected during 
delivery, the delivery will fail. Check the status of the connection with the unit and then execute 
delivery again.
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 ■Configuration directly from the menu
1 From the tree pane of the <Device Monitoring> window, select the icon for a 

device, group, or keyword, right-click it, and select  
[Content list editing and delivery].

2 Select the list to be delivered from the [Delivery content list].
• When a group or keyword icon is selected in step 1, different lists can be selected for each 

device.
• If nothing appears in the pull-down lists, it means content lists need to be created. 

(page 123)

3 Select the [Playback mode setting] ( ).
[Single-Playback]: For playback on a single projector or a single flat panel display
[Multi-Playback]: For starting playback simultaneously on multiple flat panel displays

• If the delivery target device is a projector, you cannot select [Multi-
Playback].
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4 If you selected [Multi-Playback] in step 3, set the [Parent] and [Group No].
• The [Group No] setting is identical to the group ID used to classify networks when using 

USB media players in Multi Media Player mode.
• You must also specify one flat panel display within the group as the Parent.
• If another flat panel display on the same network and with the same group ID is already 

specified as the primary display, [Parent] cannot be specified.
• To view the content that will be delivered, click [Confirmation]. The input signal, display 

mode (aspect ratio), and other information will be displayed on the corresponding flat panel 
display.

5 Deliver or save the content list.

[Delivery]:The files are saved to the USB memory inserted in the device of the delivery 
destination, and the content list delivery is executed.

[Save]: The content list is saved on the computer you are using. Specify a save 
destination. If a USB memory device used with a delivery destination device 
has been inserted into the computer, it can be directly saved on the USB 
memory device.
• The files to be saved as a content list are as follows.

- File list (filelist.dat): 
The file name of the content to be played back is recorded in this file.

- Scenario file (scenario.dat): 
The playback time of each content file, and the playback order of the 
content are recorded in this file.

- Playback file: 
This is the still image or movie file used for playback.

• To temporarily save the content lists during the editing process, click [Apply] ( ). The mid-
edit content lists will appear in the <Content list delivery> window the next time you open it.

• To discard content lists mid-creation or mid-edit, click [Cancel] ( ). You will return to the 
<Create Schedule>, <Edit Schedule>, or <Device Monitoring> window.
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Notes
• It may take a while for delivery to complete depending on the sizes of the content files.
• The functions set in “POWER MANAGEMENT SETTINGS” of the flat panel display are disabled 

during content list delivery.
• If a flat panel display that is a delivery target is playing existing content with the USB media player, 

playback stops simultaneously with the start of content list delivery and then resumes with the new 
content after delivery completes.

• If the delivery target projector is playing back an existing scenario in Memory Viewer, playback stops 
simultaneously with the start of content list delivery and then resumes with the new scenario after 
delivery completes.

• When content list delivery is executed, the settings specified in [Device list setting] are automatically 
saved. The automatically saved settings will appear in the <Content list delivery> window the next time 
you open it.

• If the power of the device unit is turned off or the connection with the unit is disconnected during 
delivery, the delivery will fail. Check the status of the connection with the unit and then execute 
delivery again.
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The software can be used to call up the device web control function.

Preparation:
• Uncheck “Use automatic configuration script” in your web browser.
• Uncheck “Use a proxy server for your LAN” in your web browser, or specify the device IP 

address in “Exceptions” in the advanced proxy settings.

1 In the Brief information display area in the <Device Monitoring> window, 
select the device you want to display, right-click it, and select [WEB 
Control].
• You can also display it by double-clicking the selected row.
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Notes
• For details about the web control function, please refer to the operating manual for the device being 

used.
• The <Web Control> window will vary according to the device being used.
• When the web control function is opened, the password change screen for the administrator account 

may appear. If the password of the administrator account is changed, re-register the device because 
acquisition of detailed information will no longer be possible. Re-register the device as described in 
“Registering Devices and Peripheral Devices to Monitor and Control” (page 24).

• If the connection setting on the device side is HTTPS communication, you cannot call up the WEB 
control function from this software. In that case, enter the device’s IP address into the URL input field 
of the WEB browser, and call up the WEB control function. 

• During [Pre-Show Mode], the logo cannot be transferred using Logo Transfer Software.
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Using the ECO Management Function
Bring up the <Web Control> window while the [ECO management set up] screen is displayed. 
You can configure the power consumption reduction settings for the projector in [ECO 
management set up].
• To display the <Web Control> window from [WEB Control] on the menu, select [Detailed set 

up] from the menu on the left, and click [ECO management set up]. (page 135)

Preparation:
• Uncheck “Use automatic configuration script” in your web browser.
• Uncheck “Use a proxy server for your LAN” in your web browser, or specify the device IP 

address in “Exceptions” in the advanced proxy settings.

1 In the Brief information display area in the <Device Monitoring> window, 
select the device you want to display, right-click it, and select [ECO 
setup].

2 Change the settings and click [Submit].
The settings will be applied to the projector. After some time, the [ECO setup level] icon in 
the row selected in step 1 will be updated. The time it takes to update differs depending on 
the [Interval time] set at [Interval Time of Device Information]. (page 143)
• What appears in the setting window will be different depending on the projector you are 

using.

Notes
• For details of the ECO Management function, refer to the operation manual of the device you are 

using.
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You can call up the Geometry manager Pro installed in your computer from this software.

1 In the Brief information display area in the <Device Monitoring> window, 
select the device you want to display, right-click it, and select [Geometry 
Manager Pro].

 ■Calling directly from the menu
1 From the tree pane of the <Device Monitoring> window, select the icon for 

a device, group, or keyword, right-click it, and select [Call application] → 
[Geometry Manager Pro].

Notes
• Only models that has the status displayed in [Geometry] can call up Geometry Manager Pro.
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This function allows you to copy the menu settings and adjustment values of the one master 
device to other multiple devices, which is similar to the LAN cloning function that is enabled 
using the device menu or dedicated tool.

• The master device data can be delivered only to devices of the same model as the one 
master device. 
To see if the projector you are using supports data cloning, refer to the “List of Compatible 
Device Models” of this application software which is posted on the following website. 
https://docs.connect.panasonic.com/projector/download/application

Acquiring the master device data
1 In the Brief information display area in the <Device Monitoring> window, 

select a device, right-click it, and select [Get adjustment data].

2 Select the save destination, and click [Save].
• The USB cloning data file acquired directly from the device is saved at the same time. 

Default file name:  Model name + Serial No.cdf (For this application) 
Model name_01.cdf (The USB cloning data file is saved in the folder 
with “Model name + Serial No.”.)

• When the message of successful saving is displayed, click [OK].
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Delivering the acquired adjustment data all at once
1 From the tree pane of the <Device Monitoring> window, select  (group 

folder), right-click it, and select [Cloning of adjustment data]. 
• Adjustment data will be delivered to all devices in the selected folder. If there is a model 

that is not applicable, it will be displayed as an error in the delivery result, which is 
displayed after delivery. (page 141)

2 When the confirmation message is displayed, click [Yes].
The delivery is cancelled when [No] is selected.
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3 Select the adjustment data file you want to deliver, and click [Open].
• In addition to the data acquired in “Acquiring the master device data” (page 139), 

the cloning data saved directly to the USB memory from the main device can also be 
selected.

• The delivery result will be displayed in the command execution log pane of the <Device 
Monitoring> window.

 - Delivery succeeded: Displayed in white letters
 - Delivery failed: Displayed in yellow letters

Notes
• For more details on the data that can be acquired by data cloning, and/or how to save the data to a 

USB memory from the device, refer to respective operating manuals of your devices.
• Do not change the file name of adjustment data that has been acquired for USB cloning, but use the 

original file name at the time of acquisition. Only the file name for this application can be changed. 
(page 139)
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Setting the Monitoring and Control’s option 
function

1 Select [Options] → [Setting] from the menu.

2 When the <Setting> window is displayed, select the tab you want to 
change the setting of and set the details.

For how to configure each setting, see the following pages.
• [General]

 - [Interval Time of Device Information] (page 143)
 - [System log entry save count] and system history deletion (page 144, 145)
 - [Port Number of Command Control] (page 146)
 - [Port number (UDP) for status notification (reception)] (page 147)

• [Detailed Information] (page 149)
• [Monitor Information] (page 149)

3 After configuring the settings, click [Close] to close the <Setting> 
window.
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Setting the Information Updating Interval
Information regarding devices being monitored/controlled can be updated at regular intervals.

1 Click the [General] tab. (page 142)

2 Set the [Interval Time].
The time interval can be selected from 1 to 90 minutes in 1-minute increments.

3 Click [Update].
An update message appears. Click [OK].
• If [Update] is clicked after characters other than 1 to 90 or no characters at all are entered 

in [Interval Time], the following message will appear.

Notes
• It may not be impossible to acquire information for all devices when there are many registered 

devices and [Interval Time of Device Information] is short. In this case, extend [Interval Time of Device 
Information].
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Setting the Number of System History Entries that 
can be Saved

Use the following steps to set the number of system history entries that can be saved.

1 Click the [General] tab. (page 142)

2 Set [System log entry save count].
From the pull-down menu, select [500], [1000] or [2000].

3 Click [Update].
An update message appears. Click [OK].
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Setting the Number of System History Entries that can be Saved

Deleting the System History Information
Use the steps below to delete saved system history data.

1 Click the [General] tab. (page 142)

2 Click [Delete system log] ( ).
Click [Yes] in the delete confirmation message that appears. The system history data is 
deleted.

Notes
• Deleting the system history information will delete the brief system history information as well.



146

Setting the Monitoring and Control functions

Setting the Port Number for Command Control
Set the port number for the command control to be used in communication with the device.

1 Click the [General] tab. (page 142)

2 Enter the port number for command control in .
• If there is a port number setting for command control in the setting items of the device to 

be used, match this setting to that setting. (Default setting value : 1024)

3 Click [Update].
When the settings are complete, a message to inform updating is complete will be 
displayed. Click [OK].

Notes
• For connecting to multiple devices, you need to make sure the port numbers match on all the devices.
• If the port number is incorrect, the information cannot be retrieved.
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Setting the Status Notification Function
Set a port number for receiving status notifications from devices.
If the status notification function is set, the error/warning information is notified promptly 
regardless of the setting of [Interval Time of Device Information]. When the power lamp flashes 
red due to a malfunction of a flat panel display, you can confirm details of the malfunction via 
this software even when in a remote location where the power lamp cannot be checked directly.

1 Click the [General] tab. (page 142)

2 Place a check mark in [Setting enabled] ( ).

3 Enter the port number for status notifications (reception) in ( ).
• Default setting value : 1024

4 Click [Update].
When the settings are complete, a message to inform updating is complete will be 
displayed. Click [OK].
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Setting the Status Notification Function

Notes
• For a flat panel display that supports the status notification function or a projector that does not 

support the push notification function, the settings in the <Web Control> window of the device (status 
notification settings page) need to be configured. For details about setting the <Web Control> window, 
please refer to the operating manual for the device being used.

• It is not possible to receive status notifications from a device if the port number entered does not 
match the port number of the device.

• For connecting to multiple devices, you need to make sure the port numbers match on all the devices.
• Errors based on status notifications received from devices are displayed in the simple  system history 

information. If an error or warning is displayed, report it to your retailer.
• For devices that support the status notification function. To see if the devices being used is supported, 

refer to the “List of Compatible Device Models” of this application software which is posted on the 
following website. 
https://docs.connect.panasonic.com/projector/download/application 
https://docs.connect.panasonic.com/prodisplays/download/software
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Changing the Information Displayed on the 
Information Display Windows

Items displayed on the Detailed Information Display (page 73) and Brief Information Display 
(page 64), as well as the display sequence can be changed.

1 Click the [Detailed Information] or [Monitor Information] tab.

[Detailed Information] window [Monitor Information] window

Items checked under [Display Item] will be displayed on each window. When you select an 
item and click [  ] / [  ], the item moves up or down and the display sequence changes.

2 Click [Update].
An update message appears. Click [OK].
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Setting the Monitoring Items for Monitoring and 
Control

1 Open the [Monitoring Settings] tab and click [Notification Settings].

For how to configure each setting, see the following pages.
• [SNMP] (page 151)
• [Mail] (page 154)
• [Error/Warning] (page 158)
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Setting SNMP Notifications
When an SNMP manager is installed on the same network as the monitoring and control 
terminal, this software can use SNMP traps to report the error, warnings and notifications that a 
device causes.

Types of SNMP traps that are sent

Type
OID

Enterprise Specific-Trap
Error occurred 1.3.6.1.4.1.258.1000.1.1 101
Error cleared 1.3.6.1.4.1.258.1000.1.1 102
Warning occurred 1.3.6.1.4.1.258.1000.1.2 101
Warning cleared 1.3.6.1.4.1.258.1000.1.2 102
A notification was sent 1.3.6.1.4.1.258.1000.1.3 101
A notification was cleared 1.3.6.1.4.1.258.1000.1.3 102

1 Open the [Notification Settings] tab (page 150), and click [SNMP].
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Setting SNMP Notifications

2 Select the [Notify by SNMP Trap] check box and configure the settings 
required for SNMP notifications.
[SNMP Manager IP Address]: Enter the IP address.
[SNMP Manager Host Name]: Enter the host name.
[SNMP Community Name]:  Enter the community name to enable authentication between 

the SNMP manager and this software.

3 Click [Update] ( ).
A message indicating that the update was successful appears. Click [OK] to update the 
settings.
• Click [Close] ( ) if you decide not to update.

4 Click [Occur] and [Recover] under [Test SNMP Trap].
This sends an SNMP trap whenever an error, warning, or notification is issued or canceled.
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Setting SNMP Notifications

Notes
• This requires that an SNMP manager runs in the system configuration you use.
• The software can only send SNMP trap transmissions initiated by the SNMPv1 [RFC1155, RFC1157] 

trap command.
• The MIB (management information base) used for sending SNMP traps can be acquired as follows.

Log in to PASS from one of the following websites.
https://docs.connect.panasonic.com/projector/pass
https://docs.connect.panasonic.com/prodisplays/pass
Click [Download] from the side menu.
Click Select Utility Software → Early Warning Software → [MIB].
Click [Download] to begin downloading.

• For details on how to set up an SNMP manager, consult your network administrator.
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Configuring the Required Settings  
for Sending Mail

Use the steps below to send data on errors, warnings and notifications caused by a device via 
mail to an E-mail address specified by this software.

1 Open the [Notification Settings] tab (page 150), and click [Mail].

2 Select the [Notify by E-Mail] check box and enter the [SMTP Server Name] 
and the [SMTP Server Port Number].
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Configuring the Required Settings for Sending Mail

3 To make an authentication server setting, click [Authentication server 
settings].
The Authentication Server Setting area appears. Select the authentication method for 
sending mail.
• Go to step 4 if you do not need to set an authentication server.

[SMTP Authentication]:  Select an authentication method from [PLAIN], [LOGIN], or 
[CRAM-MD5].

[POP Before SMTP]:  Enter the [POP Server Name], [POP Server Port Number], [User 
Name] and [Password].

4 Enter the email addresses of the sender and recipients.

[Mail Sender Address]: Enter the email address of the monitoring and control terminal.
[Mail Recipient]:  Select the check boxes and enter the email addresses of recipients in 

the same network. (Maximum of 5)
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Configuring the Required Settings for Sending Mail

5 Select the [Prevent sending Mail during following days and time.] check 
box to disable sending mail at certain times.

: Check the day of the week to disable sending of mail.
: Enter the start time, in the range “00:00” to “23:59”, at which to disable sending of mail.
: Enter the number of hours, in the range “1” to “99”, to disable the sending of mail starting 

from the time set in .

Example:
To disable sending of mail from 9pm every Tuesday to 9am Thursday and from 9pm 
every Saturday to 9am Monday, check the [Tue.] and [Sat.] check boxes, enter “21:00” in 
the time boxes, and enter “36” for the number of hours.

6 Enter [Memo].
• Enter the text to appear in the body of the email. Fill in as necessary.

7 Click [Test Mail] to send a test mail.
• Send a test email to the destination email addresses you entered in step 4.

Test mail example:
Subject: Panasonic Device Report (Test)
Body:      This is a test mail from Early Warning Software.

8 Click [Update].
A message indicating that the update was successful appears. Click [OK] to update the 
settings.

Notes
• Enter the mail address in the “***(local-part)@***(domain)” format.
• To use the mail transmission function, you must have a mail server in your system configuration. The 

mail address of the monitoring and control terminal must be registered in the mail server.
• For details on how to register and configure a mail server, consult your network administrator.



157

Setting the Monitoring Items

Configuring the Required Settings for Sending Mail

o Shipping date: June 7, 2013, 10:55:38

---------------------------------------------------------------------------------------------------

○ Device Information: 

  Group Name: Group

  Device Name: DZ21K

  IP address: ***.***.***.***

  Model Name: DZ21K

  Serial Number: AB1234567

  Main Version: 1.00

  Sub Version : 1.00

  Network Version: 1.03

---------------------------------------------------------------------------------------------------

○ Detected data: 

  Status: Warning

    Detail 1: Color prism 3, fan error
  
    Suggested action 1: Have your dealer inspect the fan.

            The color prism cooling fan 3 has reached the level threshold.

    Detail 2: Projector LAN connection error

    Suggested action 2: Check whether the LAN cable is properly connected.

            Check whether the main power supply has been turned on.

---------------------------------------------------------------------------------------------------
 
  Power: On

  Set power on hours: 16984 hrs

  LIGHT 1 power on hours: 4 hrs

  LIGHT 2 power on hours: 3 hrs

  LIGHT 3 power on hours: 3 hrs

  LIGHT 4 power on hours: 3 hrs

  Remaining time for LIGHT 1: 1996 hrs

  Remaining time for LIGHT 2: 1996 hrs

  Remaining time for LIGHT 3: 1997 hrs

  Remaining time for LIGHT 4: 1997 hrs

  Power on times: 154 times

  Color prism cooling 3 fan belt: 465
 
  Color prism cooling 3 fan data 1: 4CE
  Color prism cooling 3 fan data 2: 0AF
 
  Intake temperature: 25 degC/77 degF
 
  Exhaust temperature: 26 degC/78 degF
 
  Temperature around optical module: 30 degC/86 degF

---------------------------------------------------------------------------------------------------

○ Memo: 

Mail send date

Device setting data

Device error, warning, notification 
details and suggested action

Light power on hours, remaining 
time and temperature data

Memo data

 ■Example of Mail Transmission
Mail subject: Panasonic Device Report (Error/Warning/Information)
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Setting a Warning to Report that a Device is Not 
Connected

Use the steps below to output a warning to notify when for some reason a device is not 
connected to the network. A warning is output when connection with a device cannot be 
confirmed after a preset number of connection attempts during a device update.
If you are aware in advance that a device will not be connected on specific days or times, you 
can configure settings to disable disconnection warnings during those days or times.

1 Open the [Notification Settings] tab (page 150), and click [Error/Warning].
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2 Select the [Warn if device is not found in network] check box and enter 
[Number of retries before Warning].
Enter a value between “1” and “99”.
• If greater the number of retries before warning, the longer it will take to determine that a 

device is not connected.
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Setting a Warning to Report that a Device is Not Connected

3 Select the [Avoid warning even if device is not found in network during 
following days and time.] check box, and configure the settings to 
disable disconnection warnings at certain times.
• To keep disconnection warnings enabled at all times, proceed to step 4 without selecting 

[Avoid warning even if device is not found in network during following days and time.].

: Select the check boxes for the days on which disconnection warnings will be disabled.
: Enter the start times, in the range “00:00” to “23:59”, for the periods at which 

disconnection warnings will be disabled.
: Enter the number of hours, in the range “1” to “48”, to disable warnings starting from the 

time set in .

Example:
Configure the settings as shown in the screen above to disable disconnection warnings 
every week for 24 hours from 10:30 AM Tuesday to 10:30 AM Wednesday and for 24 
hours from 8:30 AM Saturday to 8:30 AM Sunday.

4 If there are errors/warnings for which notification by e-mail is not 
required, click [Notification setting] of [Error/Warning notification setting].
The details of detected errors/warnings and their IDs are displayed.
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Setting a Warning to Report that a Device is Not Connected

5 Select the check boxes ( ) of the IDs for which to not be notified by 
e-mail, and click [Save] ( ).
Notification by e-mail will no longer occur for the IDs with check marks.
• To restore the original settings, click [Cancel] ( ) and then click [Close] ( ).

6 Click [Close] ( ).

7 Click [Update].
A message indicating that the update was successful appears. Click [OK] to update the 
settings.
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Error Messages
Errors relating to the multi monitoring and control 
functions

 ■Cannot register a device
Message Remedy

Please register as a device administrator 
authority user.

Specify a user name and password for the administer 
privileges of the device then register.

2048 devices have already been registered. The maximum number of registered devices is 2,048. 
Be sure to stay within that range.

Create Device Failed. Confirm IP Address, 
User Name and Password. 

Confirm the IP address, user name and password of 
the device you want to register.

Create Device Failed. Cannot connect with 
the projector. 

Check LAN cable connection, and confirm the IP 
address, user name and password of the device you 
want to register.

Device with Same IP Address has already 
been registered.

Confirm the IP address of the device whose information 
is to be updated.

Device Update Failed. Confirm IP Address, 
User Name and Password. 

Confirm the IP address, user name, and password 
that were set for the device whose information is to be 
updated.

Invalid IP Address. Input correct IP Address. Confirm the IP address of the device whose information 
is to be updated.

Password for Administrator account is not 
set.
Do you want to set a password?

Set the administrator account of the device to that is to 
be registered.

 ■Cannot create a group, keyword, or brightness control
Message Remedy

100 groups have already been created. The maximum number of groups to which devices can 
be registered is 100. Be sure to stay within that range.

100 keywords have already been created. The maximum number of keywords to which devices 
can be registered is 100. Be sure to stay within that 
range.

100 Brightness Controls have already been 
created. 

The maximum number of brightness controls to which 
devices can be registered is 100. Be sure to stay within 
that range.
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Error Messages

 ■Failed to acquire brightness control
Message Remedy

Confirm whether the adjustment mode of 
the brightness control is "PC". 

Set the adjustment mode of the device's brightness 
control to "PC".

Please check that the adjustment mode of 
the brightness control is "PC", and that it 
is a model corresponding to the brightness 
control. 

Set the adjustment mode of the device's brightness 
control to "PC". Make sure that models that do not 
support brightness control are excluded from the 
brightness control group.

If a different device model is connected 
with Brightness Control group, Brightness 
Control cannot be executed.

A device that differs from the registered device was 
connected to the brightness control group. Be sure 
to connect the correct device and exclude incorrect 
models from the brightness control group.

 ■Unable to update the Device Profile Library, or register a network camera
Message Remedy

Confirm the Device Profile Library. Prepare the correct device profile library.
The selected library is same or older library 
than current one.

Prepare a device profile library that is newer than the 
one that is currently registered in the software.

Network Camera's IP Address is invalid. Correctly enter the IP address of the network camera 
you want to register.

Network Camera's User Name is required. No user name has been entered. Enter the user name 
for the network camera you want to register.

Confirm that the IP address, user name, 
and password of the network camera are 
correct.

Confirm the IP address, user name and password of 
the network camera you want to register.

Communication error occurred when trying 
to connect to Network Camera.

Check the network connection.

Can't find Network Camera. Check the network connection.
Duplicated Network Camera. This network camera has already been registered.
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Frequently Asked Questions
Check the following points once more before requesting repair.

A “401 Unauthorized ...” error is shown and the <Web Control> window cannot be displayed
Is there a mistake with the username entered when the device was registered?
• The username entered when device was registered to this software must be the same as the 

username set to display the <Web Control> window of the relevant device.

Cannot switch input from control screen of this software
Is there a mistake with the username entered when the device was registered?
• To use the input switch button of the control screen of this software, the username entered when 

device was registered to this software must be the same as the username set (with administrator 
rights) to display the <Web Control> window of the relevant device.

Acquisition of information is not possible
When “INFORMATION_ERROR” is displayed on the command execution log area of the device 
monitoring screen, confirm the device connection or authentication information.

In caption distribution, the caption display is garbled at the delivered device.
It is necessary to redo the setting of the font to be used at caption editing.
• Select an applicable caption list, and after changing the font at the caption editing screen, perform 

caption distribution once more.

Cannot convert from PowerPoint to still image or movie during content list delivery
Is PowerPoint running while the <Content list delivery> window is displayed?
• Quit PowerPoint, then open the <Content list delivery> window. 

If the problem persists after quitting PowerPoint, close the software, restart the computer, and try 
again.
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Frequently Asked Questions

An [An error occurred in communication with the monitoring service.] error is displayed, and 
the software will not launch.
Is Early Warning Software not running?
• In order to launch the software, the state of the “Early Warning Software” service must be “Running”.

1. Right-click [Start] button and select [Computer Management].

2. In [Services and Applications], select [Services], and confirm that the status of [Early 
Warning Software] is [Running].

• If the status of [Early Warning Software] is not [Running], click [Early Warning Software] and 
select [Start the service] to start it.
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Frequently Asked Questions

Is IIS (Internet Information Services) correctly configured?

1. Type “Control Panel” in the search bar to launch the control panel.

2. Select [Programs] in the Control Panel.
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Frequently Asked Questions

3. Click [Programs and Features] → [Turn Windows features on or off].

4. For the following three functions, confirm that the settings for each item are as shown 
below, then click [OK].

[.NET Framework 4.8 Advanced Services]

[Windows Process Activation Service]
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Frequently Asked Questions

[Internet Information Services]
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Frequently Asked Questions

Cannot install the software
Is Microsoft .NET Framework 4.8 installed on your computer?
• To install the software, you first have to install Microsoft .NET Framework 4.8 on your computer.

1. Type “Control Panel” in the search bar to launch the control panel.

2. Select [Programs] in the Control Panel.
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Frequently Asked Questions

3. Click [Programs and Features] → [Turn Windows features on or off].

4. Select the “.NET Framework 4.8 Advanced Services” check box and click [OK].

5. The required files are located and Microsoft .NET Framework 4.8 is installed.
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Frequently Asked Questions

6. If the files required for installing Microsoft .NET Framework 4.8 are not on your computer, a 
screen like the one shown below appears. Select [Let Windows Update download the files 
for you] in that screen. (This process requires an Internet connection.)

7. Restart the computer when installation completes.

Messages that appear when an attempt to uninstall or update the software is made
Is the “Warning 1910.Could not remove ...” message displayed?
• If an NVIDIA driver is installed on your computer, the following message may appear.

Warning 1910. Could not remove shortcut Multi Monitoring & Control Software.lnk. 
Verify that the shortcut file exists and that you can access it.

Click [OK] to continue an uninstall or update procedure.
Although uninstalling the software will also remove the desktop shortcut icons, please manually 
delete the shortcut icons when you start up the computer next time as they will be regenerated.
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Frequently Asked Questions

No connection can be made between my device and my computer
When Windows Firewall has been detected
Is the firewall exception setting turned on?

1. Type “Control Panel” in the search bar to launch the control panel.

2. Select [System and Security] in the Control Panel. 

3. Click [System and Security] → [Windows Defender Firewall] → [Allow an app through 
Windows Firewall].
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Frequently Asked Questions

4. Click [Change Settings] ( ) → [Allow another app] ( ).

5. Click [Browse] ( ).
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Frequently Asked Questions

6. Select [PJMC.exe] and click [Open] ( ).
If you do not specify a different destination, the software is installed in the following location.
C:\Program Files (x86)\Panasonic\Early Warning Software

7. Select [Multi Monitoring & Control Software Ver.XX] and click [Add] ( ).
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Frequently Asked Questions

8. Select the [Private] or [Public] network you want to allow connection to and click to select 
the check box.

9. Click [OK] ( ).
This software will now be added to the Windows Defender firewall’s exception list.

When another firewall has been detected
Are any firewall-containing applications installed?
• If any applications which contain firewalls are installed, the installation may not complete.

(The firewall function may activate without launch of the application if the application has already been 
installed.)
If this occurs, firewall settings must be changed in order to allow connection to the network.

• See the User’s Manuals for all applications containing firewalls to perform these settings.

When the software is launched, an error occurs in communication with the monitoring service.
The following message is displayed if the required data cannot be read when the software is launched:

An error occurred in communication with the monitoring service.
Since there is a possibility that the monitoring service may be stopped, restart the PC.

• Restart the computer, then launch the software again. 
If the same error occurs after restarting the computer, it is possible that the required data has 
become corrupt. 
Reinstall the software.
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Frequently Asked Questions

The screen is not displayed even when calling up the device’s WEB control function.
If the device or network camera being used is set to connect using HTTPS communication or if it is 
required to install a plug-in software, the WEB control screen may not be displayed even if you call up 
the device’s WEB control function from this software.
• When the WEB control screen is not being displayed, enter the IP address of the device or network 

camera into the WEB browser URL input field and directly open the WEB control screen.
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Trademarks
• Microsoft, Windows, Excel, PowerPoint and Microsoft Edge are either registered trademarks 

or trademarks of Microsoft Corporation in the United States and/or other countries.
• PJLink™ is a registered trademark or pending trademark in Japan, the United States, and 

other countries and regions.
• Intel is a registered trademark or trademark of Intel Corporation or its subsidiaries in the 

United States and/or other countries.
• DisplayPort is a trademark of the Video Electronics Standards Association.
• Android and Google Chrome are trademarks of Google LLC.
• iPad, iPhone, iPadOS and Safari are trademarks of Apple Inc., registered in the U.S. and 

other countries.
• IOS is a trademark or registered trademark of Cisco in the U.S. and other countries and is 

used under license.
• Other company names, product names or other names noted in these operating instructions 

are trademarks or registered trademarks of the respective companies. Note that ® and TM 
marks are not indicated in these operating instructions.

Notes:
• Unauthorized use or reproduction of part or all of this software and manuals is strictly 

prohibited.
• Panasonic Projector & Display Corporation cannot be held liable for any effects resulting 

from the use of this software and manuals.
• Panasonic Projector & Display Corporation reserves the right to revise this software 

specifications and manual contents without notice.
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